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In het NRC Handelsblad van 11 maart 2013 las ik het artikel van Michiel Hennink 
waarin hij betoogt dat de universiteiten van tegenwoordig te veel gericht zouden 
zijn op de praktijk en het bedrijfsleven. Hier valt best wat voor te zeggen: rond het 
verschijnen van het artikel van Hennink vonden op de universiteit de Bedrijvenda-
gen Twente plaats, alwaar studenten de kans kregen om kennis te maken met hun 
latere (mogelijke) werkgever(s) die hen maar al te graag naar zich toe trokken.

Veel slimme en ijverige studenten verkiezen tegenwoordig een (top)baan boven 
een academische loopbaan bij een universiteit. Daar is ook wel weer iets voor te 
zeggen: de huidige cultuur in een academische omgeving waarin je voorname-
lijk wordt beoordeeld op het aantal maal dat je geciteerd wordt, de Hirsch-index 
genaamd, klinkt mij persoonlijk ook niet erg aantrekkelijk in de oren. Doe mij dan 
maar liever een baan bij een mooi bedrijf.

Later die week kwam daar het bericht bij dat minister Bussemaker een BSA wil 
invoeren voor de hogere leerjaren in het hoger en wetenschappelijk onderwijs. Alle 
maatregelen bij elkaar genomen, lijkt het er voor aankomende studenten niet beter 
op te worden. Ze moeten gaan werken om de studie te betalen, maar moeten tege-
lijkertijd goede resultaten blijven halen of ze worden van hun opleiding verwijderd. 
Het invoeren van al die verschillende maatregelen zonder de resultaten ervan af te 
wachten leiden volgens mij tot een onoverzichtelijk allegaartje waar de huidige en 
toekomstige studenten de dupe van (zullen) worden. Niet erg gek dat er studenten 
zijn die een academische loopbaan gaan schuwen.

Ook bij de I/O Vivat merken we dat studenten steeds minder tijd te besteden heb-
ben aan commissies. Om die reden proberen we tegenwoordig vaker gastschrijvers 
te vragen om ons mooie blad te vullen zonder de kwaliteit te verliezen. Zo hopen 
we ook in de komende jaren mooie edities van het blad te blijven uitbrengen met 
kwalitatief goede artikelen.

Veel leesplezier toegewenst!

Herman Slatman

Hoofdredacteur
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Het is snel gedaan, iets liken op Face-
book. Het is dan ook niet raar dat je 
voor tientallen tot duizenden dingen 
publiek de wereld vertelt dat je dat ‘li-
ket’. In principe niets mis mee, want 
de rest van jouw gegevens zijn privé. 
En wat vertelt een voorkeur voor pan-
nenkoeken en Queen nou echt over 
jouw persoonlijkheid?

Best veel, blijkt. Met name de combi-
natie van verschillende dingen die een 
persoon liket zijn met data mining-
technieken uitstekend te analyseren. 
Een onderzoeker van de Universiteit 
van Nottingham begon een project in 
2007 om te zien wat voor patronen er te 
ontdekken waren. Door gebruikers een 

simpele verzameling vragen te geven 
over hun persoon en daarbij toestem-
ming te geven om hun ‘likes’ te verza-
melen, werd een grote dataset opge-
bouwd. 

Het getrainde algoritme van het project 
heeft een sterk onderscheidend vermo-
gen op basis van verschillende persoon-
lijke eigenschappen. Zo kan het algorit-
me met 88% zekerheid onderscheiden 
of iemand homo is, of hij/zij links of 
rechts stemt en of iemand ofwel chris-
telijk of moslim was (andere of gebrek 
aan overtuigingen werd niet meegeno-
men). Sekse en huidskleur kunnen met 
meer dan 90% nauwkeurigheid worden 
vastgesteld. Ook bleek voorkeur voor 

“wetenschap” maar ook “krulfriet” een 
indicator te zijn voor hoge intelligentie. 
Een voorkeur voor het Japanse strip/
tekenfilmfiguurtje Hello Kitty had cor-
relatie met een open karakter maar lage 
zelfverzekerdheid. De dingen die je 
leukt vindt zeggen verassend veel over 
je.

Facebook-likes vertellen meer dan je denkt

Het filmpje dat Google vrijgaf met de 
presentatie van de eerste van versie 
van Google Glass doet denken aan sci-
ence fiction. Op de binnenkant van het 
glas wordt informatie geprojecteerd: 
waar ben je, welke afspraken heb je, 
welke berichten heb je en wat het weer 
wordt. Dit alles wordt bestuurd met je 
stem. Als je vraagt: “Ok Glass,  waar 
kan ik hier in de buurt pizza krijgen?” 
krijg jij een wandelrouter naar de 
dichtstbijzijnde pizzeria. Je kunt zelfs 
de bril vragen om foto’s en video te 
maken en die meteen delen op sociale 
media.

Dit is echter geen verre toekomstmu-

ziek: Google is van plan het eerste model 
van de bril nog dit jaar uit te brengen. 
Het gaat hierbij om een eerste versie die 
vooral voor enthousiastelingen bedoeld 
ligt: de prijs ligt waarschijnlijk boven 
de 1000 euro. Volgens de eerste dragers 
van de brillen slaagt het product hier in, 
maar de spraakbesturing is zoals ver-
wacht nog niet geheel vlekkeloos.

Met het uitbrengen van de bril probeert 
Google informatie altijd beschikbaar te 
maken, zonder dat de gebruiker verzon-
ken raakt in het scherm van zijn smart-
phone. De bril is wél altijd verbonden 
met het internet; in eerste versies wordt 
dat gedaan met de energiezuinige Blu-

etooth 4.0-verbinding met een smart-
phone. De presentatie van het product 
heeft al discussies laten losbarsten over 
de privacygevolgen; iedereen met een 
bril immers video op kan nemen, welk 
moment is er dan nog écht privé?

Google presenteert eerste versie slimme bril
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I n 2001 is het artikel ‘The Seman-
tic Web’ van Tim Berners-Lee et 
al in de Scientific American ge-
publiceerd dat het volgende futu-
ristische scenario schetst over de 
toekomst van het web: 

‘Pete was muziek aan het luisteren 
toen zijn telefoon ging. Toen hij op-
nam verzond zijn telefoon een signaal 
naar alle apparaten en werd de muziek 
zachter gezet. Zijn zus was aan de lijn 
en zij belde vanuit de huisartsenprak-
tijk om te vertellen dat hun moeder een 
specialist nodig had en een behande-
ling moest ondergaan. Lucy zou haar 
Semantic web agent vragen om alle af-
spraken te maken, en Pete bood aan om 
te rijden. Lucy heeft met haar Semantic 
web agent gecommuniceerd via een 
web browser, en die heeft alle informa-
tie over de voorgeschreven behandeling 
van haar moeder opgehaald, de dekking 
van de verzekering gecontroleerd en de 
aanbieders van de nodige gezondheids-
diensten in de buurt uitgezocht…’ Het 
verhaal gaat verder en gelukkig komt 
het wel goed met Petes en Lucys moe-
der.

Hoewel we momenteel in staat zijn om 
delen van dit scenario te implementeren 
met de huidige technologie, de imple-
mentatie van dit hele scenario is nog ver 
van onze realiteit. Het is dus interessant 
om te bekijken wat nodig is om een sys-
teem te bouwen die scenario’s zoals deze 
kunnen realiseren. Ten eerste moet het 
systeem in staat zijn om de omstandig-
heden en voorkeuren van de gebruikers 

te kennen. Daarnaast moet het systeem 
ook in staat zijn om te redeneren, d.w.z. 
gebaseerd op de informatie die het sys-
teem ter beschikking heeft moet het 
systeem kunnen ‘rekenen’ en zinnige 
adviezen geven aan de gebruikers. En 
natuurlijk moet hetzelfde systeem in 
staat zijn om meerdere scenario’s te on-
dersteunen, zodat we geen nieuw sys-
teem ‘van scratch’ hoeven te bouwen 
voor elk nieuw scenario.

Geïnspireerd door verhalen zoals dat 
van Berners-Lee en de uitdagingen om 
zo’n systeem te bouwen hebben we de 
laatste jaren gewerkt aan geautomati-
seerde service compositie. In dit onder-
zoek nemen we aan dat een gebruiker 
een bepaalde functionaliteit aan het sys-
teem vraagt, en het systeem zoekt naar 
een (technische) service die deze func-
tionaliteit biedt. Als zo’n service niet 
bestaat dan probeert het systeem een 
compositie van services op te bouwen 
die de gewenste functionaliteit wel on-
dersteunt. Bijvoorbeeld een gebruiker 
die wil dineren en naar het theater er-
gens in Nederland, en het systeem com-
bineert diensten die dineren en theater 
keuzes uitzoekt en boekt.

In het proefschrift van E. Gonçalves da 
Silva is een systeem ontworpen en ge-
ëvalueerd die het mogelijk maakt om 
service composities voor verschillende 
applicaties te ondersteunen. Twee appli-
caties in verschillende domeinen (e-go-
vernment en ‘vrije tijd’) zijn door twee 
masterstudenten (J. Hoppen dos Santos 
en E. Vlieg) uitgewerkt met gebruik van 

het algemene systeem van Gonçalves 
da Silva, waardoor de algemene toe-
pasbaarheid van het systeem is aange-
toond. In dit systeem spelen ontologie-
ën een centrale rol. Een ontologie is een 
conceptualisatie van de reëel wereld die 
in het systeem wordt gerepresenteerd 
op een manier die redenering mogelijk 
maakt. Hierdoor kan een systeem bij-
voorbeeld weten dat ‘Enschede’ een lo-
catie is, ‘Wilminktheater’ een theater is 
met als locatie ‘Enschede’, en ‘De Broei-
erd’ een restaurant in Enschede is (een 
beetje ver van het centrum). Met al deze 
informatie en veel meer (wat de gebrui-
ker graag eet of doet en misschien ook 
zijn banksaldo) kan zo’n systeem dan 
aanbevelingen doen of zelfs iets voor de 
gebruiker boeken.

Dit vakgebied heeft dus vele mogelijk-
heden maar ook uitdagingen. Deze sys-
temen zijn zo goed als de kwaliteit van 
de informatie die ze ter beschikking 
hebben, en de verbanden tussen dingen 
die in ontologieën zijn vastgelegd. Het 
gebruik van sensoren en (betrouwbare) 
diensten kunnen dan ook vele applica-
ties mogelijk maken. Kortom, er is nog 
veel te doen om het scenario van Ber-
ners-Lee helemaal geïmplementeerd te 
krijgen!

Meer info:
Vakgroep ISSE
www.utwente.nl/ewi/isse/

SigmaBees
www.sigmabees.com

//Rondje Zilverling

Semantic web en service compositie

Door: Luís Ferreira Pires
Vakgroep ISSE (samenvoeging van IS en SE)
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Banken lenen in deze tijden 
steeds minder graag hun geld 
uit aan startende bedrijven. 
Ondernemers zouden geen 
ondernemers zijn als ze niet 
op zoek zouden gaan naar al-
ternatieve manieren om hun 

projecten tóch te kunnen financie-
ren. Een andere mogelijkheid naast 
geld lenen bij een bank is geld lenen 
bij particulieren. Combineer dat met 
de opkomst van social media en een 
nieuw internetfenomeen is geboren: 
crowdfunding. Als ondernemer stel je 
je idee voor aan ‘de crowd’, die op haar 
beurt ervoor kan kiezen om bij te dra-
gen in de financiering (funding).

Kickstarter

Misschien wel het bekendste voorbeeld 
van een succesvolle crowdfundingsite 
is Kickstarter. Op Kickstarter kun je 
een project starten, waarbij je duidelijk 
aangeeft wat je wilt gaan doen. Dat gaat 
vaak middels een tekstuele projectom-
schrijving, maar veel mensen voegen er 
ook een korte video aan toe. Ook dient 
ieder project een benodigd bedrag aan 
te geven. Kickstarter werkt met een 
‘all or nothing’-principe. Dit houdt in 
dat een project alleen doorgaat als het 
streefbedrag ook echt gehaald is. Wordt 
het streefbedrag niet gehaald, dan hoeft 
niemand er ook echt geld in te investe-
ren. 

Tevens wordt er bij ieder project aange-
geven wat de starter van het project die 
‘backers’ (De mensen die geld investe-

ren) ervoor terugkrijgen. Bij een project 
waarbij een nieuw bordspel zal wor-
den ontwikkeld (kosten 35.000 dollar) 
krijgen mensen die minstens 40 dollar 
investeren bijvoorbeeld een editie van 
het bordspel toegestuurd zodra deze is 
ontwikkeld.

Het succes van Kickstarter is indruk-
wekkend. In totaal zijn er zo’n 90.000 
projecten gelanceerd, waarbij er voor 
meer dan 37.000 projecten geldt dat de 
financiering al rond is. Dat betekent dus 
een succes-ratio van bijna 44 procent.  
In totaal is er al voor 435 miljoen dollar 
door mensen geïnvesteerd via de web-
site. De grootte van de projecten vari-
eert, er zijn een paar duizend projecten 
die een totale investering van minder 
dan 1000 dollar vereisten gerealiseerd, 
maar ook al zo’n vijfhonderd projecten 

waarbij er minstens een ton aan geld 
verzameld is. 

Indiegogo

Waar Kickstarter strenge eisen stelt aan 
projecten, en dus bijvoorbeeld geen 
goede doelen toelaat, is er op de web-
site Indiegogo heel wat meer mogelijk. 
Hier vindt je zelfs sportteams die op 
zoek zijn naar sponsoren om een reis 
naar grote toernooien te kunnen finan-
cieren. Als sponsor krijg je daar dan 
vaak iets kleiners voor terug, zoals een 
t-shirt of een video-serenade. Op Indie-
gogo zijn ook technologie-producten te 
vinden. Zo wordt er bijvoorbeeld geld 
ingezameld voor de massa-productie 
van een toetsenbord met geïntegreerd 
Android-besturingssysteem. Hier krijg 
je door 89 dollar te investeren zelf ook 

Geen banken meer nodig 

Figuur 1: De homepage van Kickstarter

//Artikel

Social money: Crowdfunding

Door: Michel Brinkhuis
Redacteur I/O Vivat
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al een exemplaar opgestuurd. Indiegogo 
is geen kleine speler. In totaal zijn er al 
meer dan 100.000 crowdfunding-cam-
pagnes via de website gehost. De focus 
van de website lag in eerste instantie op 
het financieren van filmprojecten, maar 
die scope ligt nu heel wat breder. Groot 
verschil met Kickstarter is dat zodra 
je geld toezegt aan 
een project, het geld 
direct wordt geïn-
casseerd. Er wordt 
niet gewacht totdat 
het hele bedrag ver-
zameld is. Als het 
eindbedrag niet wordt gehaald, dan kan 
de maker van het project ervoor te kie-
zen om iedereen z’n geld terug te geven, 
of om het te houden. Indiegogo houdt 
in dat geval wel 9% van het bedrag in 
als fee.

Het grootste project dat momenteel op 
Indiegogo heeft gelopen is ‘Operation 
Let’s build a Goddamn Tesla Museum’. 
Een actie die in totaal 1,3 miljoen dollar 
opgebracht heeft. Met deze actie werd al 
snel voldoende geld ingezameld om een 
stuk grond te kunnen kopen waar tien-
tallen jaren geleden Nikola Tesla zijn la-
boratorium hield. De actie leverde uit-
eindelijk een half miljoen dollar meer 
op dan gevraagd. 

Path of Exile

Grinding Gear Games, een Australisch 
bedrijf, wist dankzij crowdfunding een 
groot deel van de ontwikkelkosten van 
de RPG ‘Path of Exile’ te financieren. 
Toen ze het spel aankondigden kregen 
ze van veel mensen de vraag hoe ze kon-
den bijdragen om sneller naar de open 

beta van het spel te komen. Door spe-
lers alvast in-game geld te laten kopen, 
verkregen ze toegang tot dingen als een 
closed-beta en exclusieve in-game ele-
menten. Gamers konden hun steentje al 
bijdragen door een pakket van 10 dollar 
te kopen. Dat bleek een schot in de roos, 
in totaal is er meer dan een miljoen dol-

lar opgehaald met deze crowdfunding-
actie.

gTar

Dat crowdfunding snel voor heel wat 
geld kan zorgen blijkt wel uit het succes 
van gTar. gTar is een digitale gitaar waar 
je je iPhone inklikt, dankzij LED-lamp-
jes op laagdrempelige wijze kunt leren 
gitaar spelen. Een digitale gitaar bete-
kent in dat de snaren zelf geen geluid 
maken, maar dat er gemonitord wordt 
wat je met de gitaar doet. Dat signaal 
wordt doorgestuurd naar de iPhone, die 
op zijn beurt zorgt voor de verwerking 
van het signaal en geluid laat horen.

De ontwikkelaars hadden zelf geïnves-
teerd in het laten bouwen van een pro-
toype in China, en nadat zij op 21 mei 
2012 hun project lanceerden op Kick-
starter behaalden ze een ruime maand 
later, op 25 juni, de benodigde 100.000 
dollar-grens om het project te kunnen 
laten doorgaan. Het opgehaalde geld is 
ingezet om een echte productielijn te 
kunnen opzetten, en om componenten 

groots in te kunnen kopen. De gTar kan 
nu worden gepre-ordered	  voor 399 
dollar. Investeerders die voor minstens 
350$ hadden geïnvesteerd ontvangen 
ook een gitaar. Door dus voortijdig geld 
te investeren in het product verzekerden 
ze zichzelf ervan om de gitaar te kunnen 
kopen voor een lagere prijs dan de win-

kelprijs, mocht het 
project doorgang 
vinden. Minder 
dan 350$ investeren 
was uiteraard ook 
mogelijk, maar dan 
ontving je geen gTar 

maar iets kleiners zoals een t-shirt. 

Niet alles verandert in goud

Hoewel er veel succesvolle voorbeelden 
te vinden zijn van geslaagde projecten 
die door de ‘crowd’ gefinancierd zijn, 
gaat het niet altijd goed. Game-ont-
wikkelaar Chris Taylor van studio Gas 
Powered Games moest in februari een 
Kickstarter-project staken waarmee al 
meer dan een half miljoen dollar was 
ingezameld. De reden: het streefbedrag 
van meer dan een miljoen zou niet wor-
den gehaald. Eerder al ontsloeg de stu-
die veertig ontwikkelaars, omdat men 
ze geen net ontslag meer zou kunnen 
geven als het Kickstarter-project geen 
doorgang zou kunnen vinden. Vol-
gens Taylor neemt het gemak waarmee 
projecten worden gefinancierd ook af, 
omdat mensen al veel geld hebben uit-
gegeven via Kickstarter en nu eerst de 
resultaten van die investeringen willen 
afwachten.

“44% procent van de Kick-
starter-projecten slaagt”

Figuur 2: Screenshot van de crowdfunded game Path of Exile
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Figuur 3: gTar - gitaar leren spelen met je iPhone

Op eigen kracht

Hoewel het erg gemakkelijk is om een 
crowdfundingproject te starten via 
Kickstarter of Indiegogo zijn er ook 
ondernemers die helemaal zelf succes-
vol een eigen online crowdfundingpro-
ject hebben gestart. De startups Loc-
kitron (zonder sleutels, maar dankzij 
je telefoon, je huis binnen kunnen) en 
ScoutAlarm (een modern en stylish 
woningbeveiligingsssyteem) werden af-
gewezen door Kickstarter omdat ze nog 
niet genoeg gevorderd waren met de 
ontwikkeling van het product. Locki-
tron was de eerste die dat overkwam, en 
bouwden een eigen systeem en lanceer-
den een eigen campagne. Het gebouwde 

systeem publiceerden ze als open-sour-
ce via Github. Dat maakte het mogelijk 
voor het team van ScoutAlarm om het 
de code te forken en zo op eigen kracht 
een campagne te draaien. Dat bleek een 
schot in de groos, ScoutAlarm wist in 
de eerste drie weken voor 140.000 dol-
lar aan pre-orders binnen te halen. 

De ervaringen die ScoutAlarm opdeed 
met het helemaal zelf draaien van de 
crowdfundingcampagne publiceerden 
ze op hun weblog, om zo ook andere on-
dernemers te helpen. Daarbij geven ze 
vrij gedetailleerde informatie over hun 
opzet. Ze vertellen onder meer waar ze 
tegenaan liepen bij het forken  (gebruik 
maken van een afsplitsing van de code) 
van de Self Starter-code van Lockitron 

en hoe ze de performance van hun web-
site testten en ervoor zorgden dat die 
snel en goed bereikbaar bleef via He-
roku en Cloudfront.

Volwassen projecten

Crowdfunding lijkt een succesvolle 
manier om je ideeën om te kunnen zet-
ten in een echt product, ook als je daar 
zelf het geld niet voor hebt. Dat heeft 
er al voor gezorgd dat er heel wat in-
novatieve producten op de markt zijn 
gebracht. De website Outgrow.me geeft 
een overzicht van geslaagde IndiGogo 
en Kickstarter-projecten. Projecten die 
dus echt hebben geleid tot een werke-
lijk product, en die iedereen kan ko-

pen. Schoenen, pennen, 3D-printers, 
iPhone-docks, bordspellen… Kortom, 
crowdfunding heeft bijgedragen aan de 
financiering van een enorm breed scala 
aan producten. En dat lijkt alleen maar 
meer te gaan worden. Had Kickstarter 
in 2011 nog maar zo’n 20.000 projecten, 
dat aantal ligt nu twee jaar later al vier 
keer zo hoog.

Bronnenlijst
Kickstarter stats
http://www.kickstarter.com/help/
stats

‘Path of Exile haalt miljoen op via 
crowdfunding’  - Gamer.nl  
http://www.gamer.nl/nieuws/397361/
path-of-exile-haalt-miljoen-op-via-
crowdfunding

‘Coolship: An Android desktop 
computer that looks like a keyboard’  
- IndieGogo.com
http://www.indiegogo.com/projects/
coolship-an-android-desktop-
computer-that-looks-like-a-keyboard

‘Let’s build a goddamn Tesla Museum’  
- IndieGogo.com 
http://www.indiegogo.com/
projects/let-s-build-a-goddamn-
tesla-museum?website_
name=teslamuseum

‘Chris Taylor: “rek raakt uit 
Kickstarter’ - Tweakers.net
http://tweakers.net/nieuws/87288/
chris-taylor-rek-raakt-uit-kickstarter.
html

‘Want to roll your own 
croudfundingsite? Here’s what you 
need to know!’  Scoutalarm.com
http://blog.scoutalarm.com/

‘How ScoutAlarm crowdfunded 160k 
without a Kickstarter or IndieGogo’  - 
VentureBeat
http://venturebeat.com/2013/03/11/
how-scout-alarm-crowdfunded-160k-
without-kickstarter-or-indiegogo/

“ScoutAlarm blogt over 
de crowdfundingervaringen”
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militaire dienst ging het er iets anders 
aan toe. De keuring was gericht op het 
ruwweg vaststellen van de zogenaamde 
ABOHZIS: een code, bestaande uit een 
string van 7 integers tussen de 1 en 5. 
Bij elke integer hoort een letter die staat 
voor een keuringsaspect: A voor Alge-
meen, B voor Bovenste ledematen, O 
voor  Onderste ledematen, H is Horen, 
Z is Zien, I is intelligentie, en S staat voor 
Stabiliteit. Voor elke letter kreeg je een 
cijfer, waarbij 1 stond voor “dik in orde” 
en 5 voor “onacceptabel slecht”. Het 
was niet moeilijk om je op de keuring 
zó raar te gedragen dat je S5 kreeg (en 
dus afgekeurd werd), maar het gerucht 
over de mogelijk fatale invloed van het 
S5-stempel op je latere carrière zorgde 
er voor dat van deze mogelijkheid toch 
geen massaal gebruik gemaakt werd.

Wat ik zo leuk vind aan zo’n ABOHZIS 
code is dat het, in tegenstelling tot één 
cijfer, nuttige informatie bevat, en geen 
poging doet om iedereen totaal te orde-
nen. Stel dat je een mitrailleurschutter 
zoekt, dan wil je iemand met voor B en 
O een 1, maar misschien accepteer je 
voor I wel een 3. Zoek je daarentegen 
een administrateur, dan is voor I een 1 
misschien wel fijn, terwijl voor B en O 
een 3 geen probleem is. En je doet geen 
uitspraak over wie “beter” is, een schut-
ter of een administrateur.

Ik stel voor dat we dit idee overnemen 
in ons nieuwe TOM onderwijs. In een 
module gaan we toetsen op, laten we 
zeggen, kennis, inzicht, vaardighe-
den, inzet, en creativiteit, en bepalen 
zo je KIVIC code. Met een KIVIC van 
11111 ben je natuurlijk zonder twijfel 
geslaagd, en een KIVIC van 55555 leidt 
onherroepelijk tot zakken, maar over 
alle andere codes valt te praten. Zo’n 
code geeft je feedback over waar je staat, 

T oen ik nog jong was hadden 
we in Nederland een ver-
plichte militaire dienst. Om 
de Russen tegen te houden 
(of, realistischer, ze te vertra-
gen tot de Amerikanen ons te 
hulp konden komen) dachten 

we een flink leger nodig te hebben, 
en dat leger werd voor het grootste 
gedeelte gevuld met dienstplichti-
gen. Om te kijken of  iemand geschikt 
was voor het vervullen van militaire 
dienst, moest elke jongen een keu-
ring ondergaan (meisjes hoefden niet 
in militaire dienst). Die keuring was 
een gebeuren dat omgeven was met 
mythes en broodje-aap verhalen. Nog 
steeds kun je op internet de meest 
fantastische anekdotes lezen over de 
stunts die werden uitgehaald om toch 
maar afgekeurd te worden.

Hoewel die keuring voornamelijk la-
cherigheid oproept, denk ik dat we er 
voor het universitaire onderwijs toch 
iets van kunnen leren. Zo’n keuring kun 
je zien als een soort toets. Als wij van 
de universiteit zo’n toets zouden moe-
ten organiseren zouden we dat ongeveer 
als volgt doen: we zouden op allerlei on-
derdelen testjes uitvoeren, die elk in een 
cijfer resulteren. En vervolgens zouden 
we al die deelresultaten in een Excel 
sheet stoppen, die vervolgens (middels 
een gewogen conditioneel gemiddelde) 
één eindcijfer zou opleveren. En mid-
dels dat eindcijfer zouden we in staat 
zijn alle potentiële rekruten onderling 
totaal te ordenen. En vervolgens zou-
den we lang en oeverloos gaan discus-
siëren over slaagregelingen, weegfacto-
ren en compensatiemogelijkheden, over 
herkansingen, keuringsmatrijzen en de 
borging van het keuringsbeleid…

Bij de daadwerkelijke keuring voor 

het probeert niet alle studenten te or-
denen (het geeft een partiële ordening, 
zoals de kenners weten: veel interessan-
ter), en het haalt docenten uit hun Pav-
lovreacties rondom vijven en zessen. Ik 
heb me laten vertellen dat er datingsites 
bestaan waar naar je sterrenbeeld ge-
vraagd wordt. Met de KIVIC code zal 
dat voorgoed verleden tijd zijn!

Sinds april 1992 is dr. ir. Rom Lange-
rak universitair docent bij de Formal 
Methods and Tools groep van de 
faculteit EWI. Romanus (Rom) werd 
op 1 februari geboren in Dordrecht 
en ging naar het Christelijk Lyceum 
aldaar. Hij haalde op de Universiteit 
Twente met lof zijn studie Toegepas-
te Wiskunde, waar hij afstudeerde 
op een onderwerp over Databases. 
Het is dan ook niet vreemd dat hij na 
zijn afstuderen ging promoveren bij 
de toenmalige faculteit Informatica. 
Na zijn promoveren in 1992 bleef hij 
bij de faculteit werkzaam.

Rom houdt van literatuur, filosofie, 
gitaar spelen, biljarten en Taekwon-
do. Sinds september 2009 is hij de 
opleidingsdirecteur Informatica, een 
taak die hij met liefde uitvoert om 
zo het onderwijs voor zowel stu-
denten als docenten nog verder te 
verbeteren.

Door: Rom Langerak
Redacteur I/O Vivat

//Column

KIVIC en de militaire keuring

Van Rom
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Het concept van steganogra-
fie is gebaseerd op  security 
through obscurity: verberg 
de informatie die je over wilt 
brengen, zodat niemand 
doorheeft dat je communi-
ceert. Een eventuele aanval-

ler zal dus over het algemeen de be-
richten die je verstuurt, niet kunnen 
lezen. Ook bij het uitwisselen van di-
gitale informatie kan gebruikt worden 
van steganografie, bijvoorbeeld door 
een tekst te verstoppen in een afbeel-
ding. In dit artikel beschrijf ik kort 
het ontstaan en de geschiedenis van 
steganografie, enkele technieken voor 
het toepassen van steganografie op di-
gitale data, de toepassingen ervan en 
hoe men tegenwoordig steganografie 
in digitale informatie probeert te ont-
dekken.

Geschiedenis

De vroegst bekende toepassingen van 
steganografie stammen reeds uit de 5e 
eeuw voor Christus. De Historiën, één 
van de belangrijkste bronnen betref-
fende de tradities, politiek, geografie 
en strijd tussen verschillende volkeren 
uit deze tijd, werd geschreven door 
Herodotus. Hierin schrijft hij hoe De-
maratus, een Griek in dienst van het 
Perzische rijk, Sparta waarschuwde 
voor een op handen zijnde aanval door 
Xerxes. Hij zou de wax van een schrijf-
tablet hebben verwijderd, een bericht 
op het houtwerk hebben geschreven 
en het daarna opnieuw bedekt hebben 
met wax, zodat het een leeg schrijftablet 

leek. Dit schrijftablet wist hij de palei-
zen uit te krijgen, en over te brengen 
naar het Spartaanse rijk, alwaar zelfs 
de ontvangers niet direct door hadden 
dat zij te maken hadden met een ver-
borgen bericht. Een ander voorbeeld uit 
hetzelfde De Historiën is het schrijven 
van een bericht op het kaalgeschoren 
hoofd van een slaaf waarna het haar de 
tijd kreeg om terug te groeien om het 
bericht te verbergen.

Ook in de eeuwen daarna werd stega-
nografie veelvuldig toegepast. Meestal 
gebeurde dit, net als in De Historiën, 
in een periode van oorlog. Berichten 

moesten onopgemerkt van het oorlogs-
front naar het thuisfront of regelrecht 
door de frontlinie getransporteerd wor-
den. Uiteraard werd er in zulke perio-
des ook gebruik gemaakt van encryptie: 
het versleutelen van berichten met (a)
symmetrische versleuteling en één of 
meerdere sleutels. Een beroemd voor-
beeld is de Enigma codeermachine die 
door de Duitsers gebruikt werd voor het 
versleutelen van berichten. Volgens Au-
guste Kerckhoffs zou een cryptosysteem 
dat informatie verbergt niet gebaseerd 
moeten zijn op het geheimhouden van 
het systeem zelf, maar op het verbor-
gen houden van de gebruikte sleutel. 

Verborgen in het volle zicht

//Artikel

Steganografie

Door: Herman Slatman
Redacteur I/O Vivat

Figuur 1: Een Engima codeermachine
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Daarmee lijkt steganografie afgeschoten 
te worden als een veilig systeem, maar 
het gebruik van cryptografie is niet al-
tijd beter. Juist het feit dat er gebruik 
gemaakt wordt van encryptie kan voor 
een eventuele aanvaller een teken zijn 
dat er interessante informatie gecom-
municeerd wordt. Een aanvaller zal dan 

eerder geneigd zijn om je communica-
tie te willen onderscheppen. Ook zijn 
er landen waar encryptie toepassen il-
legaal is. Om dan toch berichten te ver-
sturen die niemand mag lezen kan ste-
ganografie toegepast worden.

Hoe verberg je iets?

Om informatie op een veilige manier 
te verstoppen in open zicht is het no-
dig dat de verzendende en ontvangende 
partij goed van elkaar weten hoe het be-
richt verstopt is of moet worden. Alleen 
op deze manier kunnen er betrouwbaar 
berichten verstuurd worden die ook 
daadwerkelijk gelezen kunnen worden. 
Het bericht moet zich aan een bepaalde 
template houden, zoals: elke eerste let-
ter van een woord in de eerste paragraaf 
van een tekst vormt achter elkaar gezet 
een bericht. Dit voorbeeld werd al suc-
cesvol toegepast in normale brieven, 
maar is uiteraard ook prima toepas-
baar op email. Vaak kan er voordat er 
steganografie toegepast wordt, ook nog 
cryptografie toegepast worden. De ge-
codeerde informatie wordt dus verbor-
gen in het medium. 

Bij steganografie is uiteraard het vei-
ligheidsaspect één van de belangrijkste 
onderdelen. Het is belangrijk dat de 
verborgen informatie niet makkelijk 
geautomatiseerd terug te halen is. Ver-
der is het ook van belang dat er genoeg 
capaciteit is om verborgen informatie te 
verzenden. Vaak dient er een trade-off 
gerealiseerd te worden tussen capaciteit 
en veiligheid: teveel verborgen infor-
matie kan er toe leiden dat deze eerder 
gedetecteerd wordt. Een laatste doel van 
steganografie is om robuust te zijn. Ro-
buustheid gaat hier over het feit of ver-
borgen informatie verloren gaat zodra 
er wijzigingen aan het draagmedium 
plaatsvinden. 

Een goed voorbeeld van steganografie 
van digitale informatie is het verbergen 
van een tekstbericht of een afbeelding 
binnen een andere afbeelding die als 
medium dient. Voor het medium wordt 
een onschuldige afbeelding geselec-
teerd. De te verbergen informatie wordt 
dan volgens een template ingeladen in 

deze afbeelding. De template is in veel 
gevallen vergelijkbaar met het verstop-
pen van de data in de minst significante 
bits van elke byte (Least Significant Bit 
– LSB). Elke acht bytes huist dus een 
enkele byte aan verborgen informatie. 
In een afbeelding van 200 KB past dus 
zo’n 25 KB aan verborgen informatie. 
Door de informatie in de minst signi-
ficante bits te verstoppen zal de afbeel-
ding er voor het ongeoefende oog niet 
vreemd uitzien en zal het dus niet op-
vallen dat er informatie verborgen is. 
Zelfs wanneer er meerdere bits van een 
byte worden gebruikt om informatie op 
te slaan is niet meteen duidelijk dat er 
informatie verstopt is, wat resulteert in 
de mogelijkheid om meer informatie in 
een gemiddelde afbeelding te stoppen, 
soms tot wel 3 of 4 bits per byte. Dit 
principe kan ook toegepast worden op 
geluids- en videobestanden. Deze laat-
sten hebben als groot voordeel dat ze 
relatief groot zijn, waardoor ze geschikt 
zijn om vrij grote hoeveelheden infor-
matie in kwijt te kunnen.

Een andere manier is het toevoegen van 
informatie aan bestanden op locaties die 
normaal gesproken niet geïnterpreteerd 
worden. Een voorbeeld is het toevoe-
gen van een tekst na het ‘logische’ einde 
van een bestand, bijvoorbeeld achter de 
null-terminator. Bij normale weergave 
van bijvoorbeeld een afbeelding of een 

tekstbestand zal de verborgen infor-
matie niet getoond worden, maar deze 
komt wel tevoorschijn zodra er gebruik 
gemaakt wordt van een hex viewer of 
-editor. Een nadeel van deze techniek 
is dat de bestandsgrootte uiteraard toe-
neemt, terwijl de hoeveelheid beeldin-
formatie niet toeneemt. Dit gegeven 
kan gebruikt worden om de verborgen 
informatie te detecteren. 

Informatie kan ook verborgen worden 
in uitvoerbare bestanden. Al in 2003 
kwam onderzoeker Rakan El-Khalil 
met een programma genaamd Hydan, 
dat gebruikt kan worden om berichten 
in uitvoerbare bestanden voor het x86 
platform te verstoppen. De eerste stap is 
het vinden van het uitvoerbare bestand; 
elk x86 programma is een mogelijkheid. 
Daarnaast moet je de tekstdata en een 
sleutel aan Hydan aanbieden, die daar-
na aan het werk slaat en een uitvoerbaar 
bestand inclusief geheim bericht ople-
vert. Hydan is gebaseerd op polymor-
fisme: verschillende stukken machine-
code die hetzelfde uitvoeren. In Hydan 

“... dat de verborgen informatie niet mak-
kelijk geautomatiseerd is terug te halen”

Figuur 2: Schematische werking van Hydan, een tool voor steganografie in uitvoerbare 
bestanden
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zijn dit twee sets, die we voor het gemak 
Set 0 en Set 1 noemen. Als Hydan een 
0-bit moet verstoppen, wordt een in-
structie uit Set 0 gebruikt, en voor een 
1-bit is dat een instructie uit Set 1. De 
instructies uit de verschillende sets zijn 
op zo’n manier geselecteerd dat ze uit 
evenveel bytes bestaan. Een voorbeeld 
van zo’n instructie is te zien in Figuur 
2. Dit heeft tot gevolg dat het eindre-
sultaat, een nieuw uitvoerbaar bestand, 
niet verschilt in grootte van het origine-
le bestand. Van de buitenkant lijkt het 
programma dus een legitiem program-
ma, maar kan het functioneren als een 
Trojaans paard voor informatie. Hydan 
kan ongeveer 1 byte per 110 bytes uit-
voerbare code verbergen.

Waar er de afgelopen jaren vooral ge-
bruik gemaakt werd van draagbestan-
den als medium, wordt er tegenwoor-
dig steeds vaker gebruik gemaakt van 
verschillende netwerkprotocollen en –
technieken. Het voordeel hiervan is dat 
er geen limiet meer is op de hoeveelheid 
informatie die je kan verzenden; een 
gegevensstroom via een netwerk kan 
immers zeer lang duren. Bij netwerk 
steganografie kan er gebruik gemaakt 
worden van enkele verschillende tech-
nieken. Hierbij kan bijvoorbeeld ge-
dacht worden aan het misbruiken van 
bepaalde elementen van een netwerk-
protocol.

In de TCP/IP protocolstack zou er bij-
voorbeeld gebruik gemaakt kunnen 
worden van het IP identificatieveld. Dit 
veld wordt normaal gesproken gebruikt 
om pakketten een ID te geven zodat als 
de pakketten ergens op de route opge-
splitst worden, ze naderhand weer tot 
één pakket gevoegd kunnen worden. 
Het IP ID-veld kan echter ook gebruikt 
worden door er een numerieke repre-
sentatie van bijvoorbeeld een letter in te 
plaatsen. De ontvangende partij kan de 
elkaar opvolgende pakketten uitlezen 

en alle IP ID-velden achter elkaar zetten 
om het geheime bericht te ontcijferen. 
Een ander voorbeeld is DNS tunne-
ling, waarbij het mogelijk is om infor-
matie te versturen in DNS-queries. Het 
feit dat er hier gebruik gemaakt wordt 
van standaardprotocollen die eigenlijk 
overal beschikbaar zijn en niet continu 
worden gemonitord, heeft er toe ge-
leid dat er tegenwoordig door allerlei 
partijen onderzoek wordt gedaan naar 

methoden om netwerk steganografie te 
detecteren en om netwerken tegen het 
lekken van informatie via steganografie 
te beveiligen.

Toepassingen

In dit artikel is al uitgebreid aan bod ge-
komen dat steganografie gebruikt wordt 
om informatie te verstoppen zonder dat 
duidelijk is dat die informatie aanwezig 
is. Toepassingen hiervan zijn er legio. 
Steganografie wordt onder andere door 
terroristen gebruikt om strategieën en 
informatie uit te wisselen. Tijdens raids 
die Amerikaanse militairen uitvoerden 
op complexen die door terroristen be-
woond zouden worden, werden vaak 
pornografische afbeeldingen aangetrof-
fen. Deze afbeeldingen zouden meer 
dan eens gebruikt zijn om steganografie 
op toe te passen. Ook zouden terroris-
ten gebruik gemaakt hebben van het 
versturen van spam en het plaatsen van 
EBay veilingen om informatie te ver-
spreiden.

In 2005 toonde de Electronic Frontier 
Foundation aan dat bepaalde merken 
en typen printers speciale patronen van 

minuscule puntjes produceren en welke 
gegevens er gecodeerd liggen in de pa-
tronen. Het zou gaan om de datum en 
tijd van de afdruk, alsmede het serie-
nummer van de printer. Steganografie 
wordt in deze toepassing dus gebruikt 
om de afkomst van een document vast 
te stellen. De tracking dots zouden door 
de U.S. Secret Service gebruikt worden 
om vervalsers te lokaliseren, maar zou-
den uiteraard ook voor andere doelein-

den gebruikt kunnen worden.

Digitale verspreiding van content is aan 
de orde van de dag en zeer makkelijk 
uit te voeren. Ctrl-c, Ctrl-v zal de lezer 
niet vreemd in de oren klinken. Produ-
centen van multimedia willen echter 
wel dat er geld verdiend wordt met die 
content en zetten digitale distributieka-
nalen op om multimedia te verspreiden. 
In sommige Digital Rights Management 
systemen is er daarom de mogelijkheid 
om steganografie toe te passen op de 
bestanden. Zo kan de naam van een be-
paald persoon aan wie een DVD scree-
ner verstrekt wordt, verborgen worden 
in de film. Wanneer op een gegeven mo-
ment dit bestand beschikbaar komt op 
een kanaal waar het niet voor bestemd 
was, dan kan de rechthebbende con-
troleren wie het bestand gelekt heeft en 
daarop actie ondernemen. 

Detectie van steganografie

Het aan het licht brengen van verborgen 
informatie wordt steganalyse genoemd. 
Steganalyse is er niet per se op gericht 
om de inhoud van de verborgen berich-
ten vast te stellen, maar eerder om vast 
te stellen dat er informatie verborgen is 
en met welk algoritme dit gebeurd zou 
kunnen zijn. Daarbij komt nog dat er 
vaak ook gebruik gemaakt wordt van 
encryptie van de verborgen informatie. 
Het aantonen van de aanwezigheid van 
verborgen informatie heeft dus priori-
teit over het boven water halen van de 
informatie, dat eerder als een soort bo-
nus gezien moet worden.

In het geval dat de minst significante 
bits van een afbeelding zijn gebruikt om 

“Een ander voorbeeld is 
DNS tunneling”

Figuur 3: Informatie verborgen in een afbeelding van een mandril. Links de afbeelding met 
daarin de verborgen informatie. In het midden het histogram van de originele afbeelding. 
Rechts is een duidelijke verstoring te zien in het historgram van de bewerkte afbeelding.
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informatie te verbergen kan er gekeken 
worden naar het histogram van de af-
beelding. Een histogram is een grafische 
weergave van de hoeveelheid pixels met 
een bepaalde kleurtoon. Afbeeldingen 
waarop steganografie is toegepast met 
de LSB-methode hebben vaak een ui-
terlijk vergelijkbaar met dat in Figuur 
3, waar normale afbeeldingen vaak een 
vloeiender verloop hebben. Het is dus 
over het algemeen niet erg moeilijk om 
aan te tonen dat er in een afbeelding 
steganografie aanwezig is als er gebruik 
gemaakt is van de LSB-methode.

Anders is dat bij netwerk steganogra-
fie. Omdat er bij netwerk steganografie 
gebruik gemaakt wordt van bestaande 
protocollen en bepaalde controle-ele-
menten hierin, is het vaak niet of nau-
welijks mogelijk om verborgen berich-
ten te ontdekken in netwerkverkeer. 
Er kan immers op veel verschillende 
manieren van deze protocollen gebruik 
gemaakt worden. Een eerste stap op dit 
gebied is echter al wel gezet door te kij-
ken naar visualisaties van netwerkver-
keer. De techniek wordt stegtomografie 
genoemd en is gebaseerd op anomalie 
(onrgelmatigheid) detectie.

Recente ontwikkelingen

Recent hebben Poolse onderzoekers 
een mogelijkheid gevonden om infor-
matie te versturen in de stiltes van een 
Skype-gesprek. Om dit mogelijk te ma-
ken hebben zij eerst het Skype-protocol 
onderzocht en stelden vast dat Skype 
twee ‘soorten’ datapakketten gebruikt 
die beide versleuteld verzonden wor-
den. Het eerste is een datapakket dat 
spraakinformatie bevat; deze pakketten 

zijn 130 bytes groot. De tweede soort 
zijn pakketten die verstuurd worden 
zodra er niet gesproken wordt. Deze zo-
genaamde ‘stiltepakketten’ zijn 70 bytes 
groot. De onderzoekers ontwikkelden 
een tool genaamd SkyDe (Skype Hide), 
dat deze stiltepakketten benut om in-
formatie te verzenden. In Figuur 4 is 
de werking van het programma sche-
matisch weergegeven. De zendende en 
ontvangende partijen van de geheime 
data dienen van te voren een sleutel af 
te spreken waarmee de berichten ver-
sleuteld en ontsleuteld worden. De SS 
en SR in de afbeelding kunnen overeen-
komen met Alice en Bob, maar dit hoeft 
niet altijd zo te zijn. Een derde partij 
kan ook inbreken op het gesprek om 
versleutelde informatie te versturen in 
het gesprek dat Alice met Bob voert. De 
onderzoekers zeggen gemiddeld 2Kbps 
te kunnen versturen met SkyDe.

Waar steganalyse in het verleden vooral 
gericht was op het detecteren van be-
kende steganografietechnieken, zoals 
LSB, wordt er tegenwoordig steeds va-
ker gekeken naar manieren om stegana-
lyse statistisch en lerend toe te passen, 
die makkelijk geautomatiseerd kunnen 
worden. Machine learning is hierbij ui-
teraard een belangrijk aspect. Een lear-
ning classifier kan gebruikt worden om 
steganalyse te automatiseren. Het sys-
teem krijgt een grote hoeveelheid test-
data aangeleverd waarbij is aangegeven 
of het om een normaal bestand gaat, of 
dat er steganografie op is toegepast. De 
learning classifier kan aan de hand van 
bepaalde attributen vaststellen welke 
het vaakst voorkomen in de normale 
bestanden en in de steganografiebe-
standen. Als het systeem genoeg geleerd 

heeft, zal het in staat zijn om met een 
bepaalde nauwkeurigheid bestanden te 
classificeren als normaal of als verdacht 
bestand door opnieuw te kijken naar de 
attributen. Op deze manier kan er snel 
een oordeel over een grote hoeveelheid 
bestanden gegeven worden, wat nor-
maal gesproken veel tijd zou kosten bij 
handmatige detectie van steganografie.

Conclusie

Steganografie wordt al sinds de Klas-
sieke Periode gebruikt om op verborgen 
wijze berichten of informatie over te 
brengen. Tegenwoordig wordt stegano-
grafie vooral gebruikt door partijen die 
een confidentiële wijze van communica-
tie nodig hebben. Zij gebruiken diverse 
technieken en verschillende media om 
hun berichten te verbergen en te ver-
sturen, en maken hierbij soms ook ge-
bruik van encryptie als extra veiligheid. 
Recente ontwikkelingen zijn er niet al-
leen op gericht om betere technieken 
te ontwikkelen, maar tegelijkertijd ook 
om steganalyse, dat gebruikt wordt om 
communicatie door middel van stega-
nografie aan te tonen, te vergemakkelij-
ken. Dat kan zeker praktisch zijn, want 
er is meer dan het oog ontmoet.

Figuur 4: Schematische weergave van de werking van SkyDe



I/O VIVAT    

28.3 //16

I n de maand december van 2012 
begon in Dubai de conferentie 
over de toekomst van het inter-
net. De conferentie werd geor-
ganiseerd door de International 
Telecommunication Union die 
onderdeel uitmaakt van de Ver-

enigde Naties. Op dit moment valt 
het beheer van het internet onder het 
Amerikaanse Ministerie van Handel. 
De motie die ingediend werd door 
onder andere Rusland, China en Sa-
oedi-Arabië, probeert die controle in 
de handen te brengen van individuele 
landen. Maar wat voor een gevolgen 
kan deze verandering hebben?

Wie is nu de eigenaar van het internet?

Het internet heeft geen centrale eige-
naar, in zowel de technologische im-
plementaties als de beleid vormen die 
gelden voor toegang en gebruik; elk 
onafhankelijk netwerk zet zijn eigen 
standaard. Alleen het overkoepelende 
Domain Name System(DNS) en het 
Internet Protocol address (IP) worden  
beheerd door een maintainer organisa-
tie, het Internet Corporation for Assig-
ned Names and Numbers(ICANN).

De technische standaardisatie van de 
core protocols (IPv4 en IPv6) vallen 
onder de verantwoordelijkheid van de 
Internet Engineering Task Force(IETF), 
een non-profit organisatie bestaande uit 
internationale leden waar iedereen kan 
bijdragen aan technische kennis.

Op het huidige moment wordt de ont-

wikkeling van het internet dus overzien 
door organisaties als het ICANN die 
deel uit maken van het Amerikaanse 
Ministerie van Handel. Volgens het 
Amerikaanse Ministerie van Buiten-
landse Zaken, geloven de Verenigde 
Staten dat de multi-stakeholder-institu-
ten, die op het moment gelden, effectief 
functioneren en er dus geen reden is op 
de huidige situatie te veranderen.

Eurocommissaris voor ICT Neelie 
Kroes, en het Europees Parlement zijn 
ook beide tegenstanders van de plan-
nen om de macht over het internet in 
de handen van individuele landen te 
plaatsen. Hoewel het Europese Parle-
ment van mening is dat ook op dit mo-
ment de situatie waarbij de ICANN veel 
macht bezit, verre van ideaal is, blijven 
ze bang dat het voorstel de deur openzet 

voor censuur. Overigens is er geen wet 
of richtlijn die bepaalt dat het ICANN 
de controle over het internet heeft; dat is 
historisch zo gegroeid. Er is verder ook 
geen regel waarmee de huidige positie 
van het ICANN mee kan worden weg-
genomen.

Het voorstel van Rusland

Aan de situatie zoals hij nu bestaat wil 
President Vladimir Poetin van Rusland 
een einde maken. Hij zou van plan zijn 
geweest tijdens de conferentie in Dubai 
het ITU vergaande bevoegdheden te ge-
ven om zodoende het internet in de ga-
ten te kunnen houden.1 Het ITU melde 
echter dat er op dat moment geen plan-
nen van dergelijke aard waren.

In het voorstel, aangeleverd door onder 

De macht over het internet

Figuur 1: Voorzitter ICANN zet een stemronde in.

//Artikel

West vs. Oost

Door: Martijn Bruning
Winnaar AVI-1
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andere de grootmachten Rusland en 
China, wordt het internet omschreven 
als een globaal telecommunicatienet-
werk waarvan de verschillende delen 
onder het zeggenschap moeten vallen 
van de individuele ITU-leden. Daartoe 
gerekend worden internet providers en 
dataverkeer die binnen de ‘landsgren-

zen’ van een lidstaat vallen. Volgens het 
ingediende voorstel zouden de lidstaten 
de macht moeten krijgen om individu-
eel internetverkeer naar eigen belang te 
beheren en vorm te geven. Ook zouden 
lidstaten zelfbeschikking moeten krij-
gen over hun eigen domeinnamen en 
wordt er geëist het dat elk ITU-lid in ge-
lijke mate IP-adresruimte verkrijgt. 

Omstreden voorstel over internetcon-
trole ingetrokken

Na uitlekken van het eerder genoem-
de voorstel op maandag 10 december 
werd op verschillende nieuwspagina’s 
die hiervan melding maakte, fel gerea-
geerd. Verschillende gebruikers maakte 
zich grote zorgen over de mogelijkheid 
hun vrijheid op het internet te verlie-
zen. Ook was er veel commentaar op de 
macht die de overheden hierdoor kun-
nen gaan misbruiken. De eerstvolgende 
dag van het congres werd het omstre-
den voorstel om de controle over het in-
ternet over te hevelen naar individuele 
landen, weer ingetrokken.

Het intrekken van het uitgelekte plan, 
betekent niet meteen dat deze huidige 
situatie veranderd is. Volgens persbu-
reau Reuters meld een anonieme deel-
nemer aan de conferentie dat er nog 
meer vergelijkbare voorstellen op tafel 
zijn. Maar voorlopig is het wel een over-
winning voor het vrije internet.

Chaotische stemronde brengt voorstel 
weer op tafel.

Niets bleek minder waar te zijn, zo 
bleek uit een nachtelijke vergadersessie 
op donderdag 13 December waar door 
Saudi-Arabië een clausule werd inge-
diend ter bevordering van “een gunstig 

klimaat ter verdere bevordering van 
de groei van het internet.” Dit voorstel 
is eveneens gelijk aan het voorgaande 
voorstel in de zin dat het als doel heeft 
de controle over het internet in handen 
te brengen van individuele ITU-lidsta-
ten. Naar verwachting was ook hier de 
VS fel tegen de ingediende clausule. VS-

ambassadeur Terry Kramer zei: “Wij 
geloven niet dat de focus van deze con-
ferentie op het internet hoort te liggen, 
ook zijn we niet naar deze conferentie 
gekomen in verwachting een discussie 
over het internet te houden.”2

De delegatie van de VS bestaat uit top-
mensen uit de IT wereld waaronder 
mensen van Microsoft en Google. Vol-
gens Michael Beckerman, president 
en CEO van The Internet Association, 
kunnen de in de clausule vermelde ver-
anderingen permanente veranderingen 
teweeg brengen op het framework van 
het internet.

“Het unieke karakter van het internet – 
vrij van overheid controle en overzien 
door verschillende stakeholders – heeft 
een groei in ondernemerschap, creati-
viteit, innovatie en vrijheid teweeg ge-
bracht op een schaal ver boven ieders 
verwachtingen. Een vrij internet is es-
sentieel voor het behoud van politieke 
en economische vrijheid.”2

Voorzitter van de conferentie, Moham-
med Nasser al-Ghanim, voorde een pei-
ling uit door voorstanders te vragen zich 
kenbaar te maken door een bordje op te 
houden. Uit deze peiling concludeerde 
de voorzitter dan een meerderheid van 
de aanwezigen voor het voorstel was. 
Dit tot grote verwarring bij aanwezigen, 
De ITU besluit normalerwijs door mid-
del van consensus en als er sprake is van 
een stemronde dient dit duidelijk van te 
voren aangegeven te worden.

Het einde van het internet zoals we 
het kennen?

Vrijdag 14 december werd kenbaar ge-
maakt dat het verdrag officieel is aan-

genomen, ondanks het verzet van Wes-
terse landen, waaronder de Verenigde 
Staten, Nederland en het Verenigd Ko-
ninkrijk, de landen vrezen voor de ge-
volgen.

Hoewel een meerderheid van de aanwe-
zigen op de conferentie voor het verdrag 

van de ITU hebben gestemd, treedt het 
niet in werking voor de landen die het 
weigeren te ondertekenen. Nederland, 
de Verenigde Staten, Australië,  Noor-
wegen, Griekenland, Denemarken en 
het Verenigd Koninkrijk hebben ken-
baar gemaakt het verdrag niet te zullen 
ondertekenen. Deze landen zullen dan 
nog steeds gebonden zijn aan het ver-
drag van 1988 volgens Sarah Parkes, een 
woordvoerder voor de ITU.3

Veel IT bedrijven hebben laten weten 
teleur gesteld te zijn in de uitkomst, 
hoewel er voortgang is geboekt op het 
gebied van transparantie is de integriteit 
en het idee waar het internet voor staat 
in gevaar gebracht. “Wat duidelijk is 
van de ITU meeting in Dubai is dat veel 
overheden meer regulatie en censuur 
willen over het internet.” Aldus Google. 
Hoewel de conferentie nu ten einde is 
gekomen blijft de vraag hoe de situatie 
zich nu verder gaat ontwikkelen. Het 
enige waar we zeker van kunnen zijn is 
dat we nu, meer dan ooit, moeten vech-
ten voor onze vrijheid op het internet.

“Wij geloven niet dat de focus van  
deze conferentie op het internet hoort 

te liggen”

Bronnen
http://www.bbc.co.uk/news/
technology-19106420

http://news.yahoo.com/un-group-
gives-nod-greater-internet-oversight-
072246770--finance.html

http://www.bloomberg.com/
news/2012-12-13/u-s-and-u-k-
refuse-to-sign-un-agreement-on-
telecommunications.html

ITU
http://www.itu.int/en/Pages/default.
aspx

ICANN
http://www.icann.org/
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Figuur 1: Met name Android heeft een bijzonder succes op de mobiele markt geboekt.

Door: Rick van Galen
Redacteur I/O Vivat

//Artikel

Niets wijst erop dat de revolutie voor-
bij is

Mobiele revolutie deel twee

Begin 2012 zou een beschouwing 
van de mobiele markt de indruk 
gewekt kunnen hebben dat het 
allemaal wel beslist zou zijn. 
Android-telefoons van zo’n 4 
inch groot zouden de markt 
helemaal veroveren, en zowel 

Apple als Microsoft zouden hun eigen 
niches aanspreken. Het was duidelijk 
wat een telefoon was, wat een tablet 
was, maar deze twee zouden buiten 
hun eigen toepassingsgebied weinig 
groeien. De échte innovatie leek heel 
even verdwenen te zijn nadat de markt 
tot bedaren kwam na de spectaculaire 
groei die vijf jaar geleden begon.

Maar de innovatie is niet verdwenen. In 
dit artikel bieden we een overzicht van 
ontwikkelingen in de mobiele markt 
die duidelijke maken dat de ‘revolutie’ 
nog lang niet over is.

Platformenstrijd

Sinds de introductie van de iPhone in 
2007 en de iPad in 2010 is Apple de 
smaakmaker van de markt voor mo-
biele besturingssystemen met iOS. Hoe-
wel Apple zeer succesvol is, brengt de 
gerichte strategie van Apple een beperkt 
publiek met zich mee. Google was met 
Android in 2008 precies op tijd om de 
concurrentie met Apple aan te gaan: het 
was in 2009 en de jaren daarna het enige 
serieuze alternatief voor iOS en kon bo-
vendien als open source-project door 
elke fabrikant gebruikt worden. Door 
deze voordelen kon Android een enorm 
marktaandeel verkrijgen. 

Dit maakte de mobiele markt de afgelo-
pen jaren een tweestrijd tussen de plat-
formen van Apple en Google. De twee-
strijd was heftig: het bracht voormalige 
giganten Nokia, Microsoft en Black-
berry (voormalig RIM) op hun knie-
ën. Deze bedrijven deelden voorheen 
tezamen met Palm de lakens uit op de 
mobiele markt. De oude systemen van 
deze giganten beschouwden de telefoon 
echt als een kleine desktopcomputer en 
werden snel vervangen toen Apple en 
Google hun veel betere gebruikerser-
varing presenteerden. Het gebrek aan 
overtuigende producten decimeerde 
het aandeel van de betrokken bedrijven 
in de markt.

Palm probeerde als eerste de concur-
rentie aan te gaan maar werd de ver-
getelheid ingedreven toen het niet snel 

genoeg overtuigende producten op de 
markt kon brengen. Blackberry heeft 
het een tijd geprobeerd te redden op 
zijn oude platform, maar is nu bezig om 
een nieuw systeem te introduceren om 
in de toekomst op te bouwen; dit is ziet 
er nog niet uit als een indrukwekkende 
poging. Microsoft en Nokia hebben de 
handen ineen geslagen met Windows 
Phone, en lijken door grote investerin-
gen, unieke software en het uitbrengen 
van redelijk succesvolle hardware een 
niche te verkrijgen tussen de andere 
platformen.

Het wordt nu aangenomen dat het zon-
der de invloed en financiële kracht die 
Microsoft en Nokia hebben niet meer 
mogelijk is voor nieuwe spelers om 
zich te mengen in de platformenstrijd. 
In West-Europa en Amerika bezit on-
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geveer de helft van de bevolking een 
smartphone met daarop voornamelijk 
Android of iOS. Een nieuw platform 
moet eerst aan de catch-22 van de mo-
biele markt zien te voldoen: om populair 
te worden moet je veel apps voor je plat-
form beschikbaar te hebben, maar om 
veel apps voor je platform beschikbaar 
te blijven moet je 
een populair plat-
form hebben.

Een nieuw prestatie-
niveau

Deze platformstrijd barst los op een 
nieuwe generatie mobiele processors die 
veel sneller is dan ooit tevoren. Op mo-
ment van schrijven bevat de Qualcomm 
Snapdragon S4 Pro een processor die 
te vergelijken valt met pc-processors in 
het middensegment uit 2005, en Apple’s 
A6X bevat een gpu die ook met pc-tech-
nologie uit die tijd te vergelijken valt. 
Dit zijn al knappe prestaties, maar het 
wordt in de toekomst nog sneller.

Dit jaar verschijnen de eerste appara-
ten met een system-on-a-chip (SoC) 
gebaseerd op ARM’s Cortex A15-ar-
chitectuur. Deze architectuur is vooral 
ontwikkeld met het de hogere vraag 
naar tablets, smart TV’s en andere 
stroomslurpende toepassingen, maar 
zal op termijn ook worden ingevoerd 
in smartphones. De komende jaren gaat 
ARM ook 64-bitsystemen uitbrengen 
om de geheugenmogelijkheden van 
smartphones uit te kunnen breiden. 
Daarnaast is ook Intel bezig om de 
kracht van de x86-architectuur geschikt 
te maken voor smartphones.

De kracht van deze mobiele SoCs be-
nadert snel het niveau dat snel genoeg 
is om productief op te werken. Diverse 
office-applicaties zijn al beschikbaar 
voor telefoons, en ook applicaties als 
Photoshop en zelfs IDE’s vinden hun 
weg langzamerhand naar telefoons en 
tablets. Canonical wil met zijn eerder 

genoemde Ubuntu Touch het mogelijk 
maken om een telefoon aan te sluiten op 
extra hardware om echt kantoorwerk 
ook op mobiele apparaten mogelijk te 
maken. Daarvoor wil Canonical ook 
een Android-applicatie uitbrengen.

De toename van processorkracht maakt 
het mogelijk dat bijna iedereen in de 
toekomst dus nog maar één apparaat 
zou hoeven bezitten. Dat gaat in tegen 
de trend die nu door Google en Apple 
wordt aangevoerd om data niet op een 
enkel apparaat te bewaren, maar via de 
cloud te synchroniseren tussen verschil-
lende apparaten en altijd toegankelijk te 
zijn. Welk van deze twee manieren gaat 
overwinnen zal de toekomst uit moeten 
wijzen.

Wat is een mobieltje eigenlijk nog?

Als je in 2008 een high-end telefoon 
kocht kreeg je een scherm met een di-
agonaal van maximaal 9 centimeter, 
zodat het ‘goed in je zak zou passen’. 
Een high-end telefoon in 2013 heeft een 
schermdiagonaal van zo’n 13 centimeter 

en heeft het formaat van een halve bo-
terham. Grote telefoons met diagonalen 
tot 16 centimeter worden ook populair, 
met name in Korea en Japan. Deze te-
lefoons benaderen de grootte van appa-
raten die traditioneel als tablet worden 
gezien.

Het is duidelijk dat 
de termen ‘telefoon’ 
en ‘tablet’ niet meer 
gescheiden kunnen 
blijven. Dit vergt 
b estur ingssyste-
men, applicaties en 

websites die écht dynamisch kunnen 
schalen naar de grootte van een appa-
raat. Responsive design is de oplossing 
hiervoor: het ontwerpen van een ap-
plicatie op een dusdanige manier dat 
deze altijd optimaal gebruik maakt van 
de gegeven schermruimte. Aangezien je 
als ontwikkelaar nooit meer zeker kan 
weten op wat voor een scherm jouw 
product bekeken wordt, zal dit de stan-
daard worden de komende jaren.

In de platformoorlog lijkt de huidige 
trend naar producten tussen wat tradi-
tioneel als telefoon en tablet inligt in het 
voordeel te zijn van Android. Dit is op 
het moment het enige grote besturings-
systeem dat kan schalen van klein naar 
groot. Zowel Apple als Microsoft delen 
hun producten nog in discrete klasses 
in. Het is te verwachten dat zij en andere 
spelers dit in de toekomst gaan veran-
deren.

NFC en Bluetooth 4.0

De integratie van de mobiele telefoon 
met de omgeving, dat zou een grote 
revolutie worden. Althans, dat was het 
idee toen in 2010 Google de grote push 
maakte met near field communication 
(nfc) in Google’s ontwikkelaarstelefoon 
van dat jaar. Elke telefoon zou op die 
manier draadloos interactie aan kun-
nen gaan met kledingstukken, betaalau-
tomaten, paspoorten, roltrappen, brie-
venbussen en nog veel meer zaken. Dit 
alles zonder het aanleggen van batterij-
tjes of een netwerkinfrastructuur, maar 
met goedkope, passieve chips die overal 
in verwerkt konden worden.

Die belofte is nog niet helemaal waar-
gemaakt; afgezien van een beperkt aan-
tal diensten voornamelijk in Azië en 
Noord-Amerika worden nfc-mogelijk-
heden nog niet ingezet. In Nederland is 

“De concurrentie werd ge-
decimeerd”

Figuur 2: Nvidia’s Cortex A15-afgeleide gaat tot de kractigste chips van 2013 behoren.



I/O VIVAT    

//2028.3

een initiatief dat opgezet werd door de 
grote banken en telecomproviders ook 
nog niet tot wasdom gekomen.

De reden hiervoor is dat er nog geen 
grote industriële push is geweest, en dat 
maar een minderheid van de telefoons 
voorzien is van een nfc-chip. Met name 
het ontbreken van ondersteuning van 
Apple is voor de standaardisering een 
doorn in het oog. De mobiele industrie 
volgt meestal het 
voorbeeld van Ap-
ple, maar nfc-mo-
gelijkheden zijn nog 
altijd niet te vinden 
in de iPhone. Ge-
zien het feit dat de 
iPhone nog steeds het meest verkopen-
de individuele toestel ter wereld is, moet 
men wachten tot Apple overstag gaat en 
ook nfc gaat ondersteunen. Slechts dan 
kan het toekomstbeeld dat een telefoon 
kan interacteren met alles in een omge-
ving de eerste stap zetten. 

Een extra mogelijkheid voor interac-
tie met de omgeving komt in de vorm 
van Bluetooth 4.0. De vierde iteratie op 
de draadloze communicatiestandaard 
brengt een belangrijk low power-profiel 
dat het mogelijk maakt om lang da-
taverbindingen draadloos in stand te 
houden zonder dat dit een significante 
impact heeft op batterijduur. Dit maakt 
het mogelijk voor de telefoon om met 
accessoires te verbinden, zoals de futu-
ristische Google Glasses-bril (zie ook 
het nieuws in deze Vivat)  of een slim 
horloge waarop je berichten kunt lezen 
zonder naar je telefoonscherm te moe-
ten staren.

4G en de Cloud

Je hebt misschien de reclames van KPN 
gezien – dit jaar nog wordt 4G uitgerold 
in een redelijk groot gedeelte van Ne-
derland. Deze vierde generatie mobiele 
netwerken maakt grotere snelheden 
mogelijk. Maar dat is niet de belangrijk-
ste verbetering: de onderliggende tech-
nologie genaamd lte maakt het in het 
bijzonder mogelijk dat telefoonpalen 

een veel grotere capaciteit aankunnen 
en ook dat het instellen van de verbin-
ding een stuk minder tijd kost.

Het resultaat is dat mobiele verbindin-
gen met lte er altijd moeten gaan zijn. 
Waar huidige 3G-verbindingen op 
drukke locaties snel overbelast zijn en 
het bereik soms erg tegenvalt, zou dit 
bij 4G een stuk minder moeten voorko-
men. 

Heb je altijd internet, dan kun je altijd 
bij de cloud. Daarom zal de cloud als 
opslagplaats steeds nadrukkelijker naar 
voren worden geschoven. Onze docu-
menten zijn instantaan beschikbaar via 
Dropbox en Google Drive, en onze me-
dia zal beschikbaar zijn via diensten als 
Spotify en Netflix. Als 4G de beloften 
waar kan maken over een snelle, altijd 
aanwezige verbinding kan dit het nut 
van lokale opslag laten verdwijnen. Het 
zal afhankelijk zijn van de implemen-

tatie van telecomproviders en ook van 
het succes van concepten als het eerder 
genoemde Ubuntu Touch.

Onduidelijkheden

Het zou makkelijk zijn als de mobiele 
markt goed te voorspellen zou zijn, 
en dat we zouden weten met wat voor 
soort technologie we in de nabije toe-
komst te maken zouden hebben. Als 

ontwikkelaar of in 
de bedrijfsstructuur 
rekening houden 
met de huidige sta-
tus quo kan er toe 
leiden dat men snel 
achterhaald word 

als nieuwe technologieën ten tonele 
verschijnen.

Welke platformen zullen in de toekomst 
belangrijk zijn? Werkt men vanuit de 
cloud of heeft iedereen al zijn gegevens 
op één enkel apparaat? Is nfc een tech-
nologie die echt gebruikt kan worden of 
blijft het toekomstmuziek? Het is duide-
lijk dat het laatste Vivat-artikel hier nog 
niet over geschreven is.

Figuur 3: Betaling door oplegging van je telefoon: in Nederland nog even toekomstmuziek. 

“Blijft het allemaal toe-
komstmuziek?”

Bronnen
http://www.theverge.
com/2012/5/24/3041239/android-ios-
smartphone-market-share
The Verge

http://www.androidworld.nl/125202/
google-wallet-gaat-paypal-achterna-
nog-niet-nederland/
AndroidWorld.nl

http://www.ubuntu.com/phone
Canonical



I/O VIVAT    

//2128.3

Door: Koen Tinselboer
Softwareontwikkelaar bij OVSoftware

//Op bezoek bij

OVSoftware

Contactinformatie
OVSoftware b.v.

Burgermeester Wallerstraat 179
7574 AN Oldenzaal
T: 0541-533111
E: employment@ovsoftware.nl

Een ICT-bedrijf dat al veertig 
jaar bestaat. Dat komt niet zo 
vaak voor en is uniek in de ICT 
branche. In deze ‘Op bezoek 
bij’ spreken we met Koen Tin-
selboer, softwareontwikkelaar 
bij OVSoftware. Hij studeerde 

in 2007 af na Technische Informatica 
op de Universiteit Twente te hebben 
gestudeerd en startte een jaar later bij 
OVSoftware. Koen heeft aan de UT na 
zijn bachelor de master Databases & 
Informatiesystemen gedaan; een rich-
ting waarin hij nu bij OVSoftware ook 
actief is.

OVSoftware ontwikkelt maatwerk 
software-oplossingen voor klanten. 
Dat maakt het werken erg afwisselend, 
want medewerkers wisselen met enige 
regelmaat van bedrijf waar ze worden 
gedetacheerd. Koen is begonnen  bij 
OVSoftware met  een opdracht voor 
de Gemeentelijke Basis Administratie 
(GBA). Hij heeft dit systeem omge-
bouwd van HP-UX naar Linux en ook 
deels aanwezige stukken Propriëtaire 
softwarecode herschreven. Hiermee is 
een moderniseringsslag gemaakt, waar-
door flink op kosten is bespaard. 

In maart 2010 veranderde Koen van op-
drachtgever en werd gedetacheerd bij 
reisconcern TUI Nederland, onder meer 
bekend van de merken Arke, Holland 
International, KRAS.NL, ROBINSON 
en haar eigen luchtvaartmaatschappij 
ArkeFly. Koen houdt zich  bezig met het 
koppelen van de applicatie die TUI in 
België gebruikt, een extranet voor travel 
agents en reisleiding in het buitenland, 
aan het Nederlandse systeem. In dit sys-
teem kunnen hoteliers zien welke boe-
kingen er zijn. Dankzij dit systeem vindt 
er een verschuiving plaats van papieren 
communicatie (fax) naar digitale com-

municatie via een web based omgeving. 
Daarnaast houdt hij zich ook bezig met 
andere datakoppelingen. TUI heeft een 
grote ICT-afdeling met veel verschil-
lende applicaties waarbij integratie een 
belangrijk speerpunt is. 

“Werken als softwareontwikkelaar bij 
OVSoftware betekent meer dan  al-
leen maar ‘code kloppen’,” zo benadrukt 
Koen. “Programmeren is een belang-
rijke taak maar we stellen ook  require-
ments op, maken een ontwerp en ook 
communicatie met de opdrachtgever 
is een belangrijk onderdeel van mijn 
functie.” Bij OVSoftware werkt onge-
veer 30% intern op één van de vestigin-
gen (Den Haag, Oldenzaal en Münster) 
aan ICT-projecten en de  overige mede-
werkers zijn gedetacheerd bij regionale 
opdrachtgevers.  Het type klanten waar-
voor OVSoftware werkt is heel divers. 
Van kleine tot grote ondernemingen, 
zowel in het bedrijfsleven (bijvoorbeeld 
TUI, Nedap) als bij de overheid (bij-
voorbeeld de Belastingdienst).

Tijdens zijn  dagelijkse werkzaamheden 
merkt Koen  dat de praktijk veel meer 
is dan  datgene dat je op de universiteit 
leert. “Naast de techniek komen er  veel 
meer ‘soft skills’ bij kijken. Om te zorgen 
dat je die skills voldoende beheerst heeft 
OV Software een trainingsprogramma 
voor alle software ontwikkelaars.” 

Koen werkt nu vijf dagen per week in 
het prachtige nieuwe kantoorpand van  
TUI in Enschede. Daarnaast  heeft hij 
altijd veel contact met collega’s van 
OVSoftware in Oldenzaal, onder ande-
re door de maandelijkse company mee-
ting, bedrijfsuitjes en door de andere ta-
ken die hij op zich heeft genomen  zoals 
het begeleiden van stagiaires. Daarnaast 
merkt Koen op: “Hoe meer ik me ont-

wikkel in mijn functie, hoe meer ver-
antwoordelijkheden ik heb gekregen.” 
Daarnaast roemt hij het afwisselende 
werk bij OVSoftware. “Daarmee bedoel 
ik niet alleen de verschillende opdracht-
gevers, want een opdrachtgever heeft 
ook verschillende opdrachten maar 
zeker ook de mogelijkheden om jezelf 
verder te ontwikkelen.  ‘softwareont-
wikkelaar’ bij OVSoftware heeft geen 
strak omlijnde functieomschrijving, 
waardoor je de functie kunt uitbreiden 
en  vormen zoals  je deze zelf graag  ziet.

Heb je interesse in OVSoftware en wil je 
meer te weten komen over dit bedrijf? 
Kijk dan op www.ovsoftware.nl 

OVSoftware is continue op zoek naar 
software specialisten (ook zonder erva-
ring). Bovendien hebben ze regelmatig 
plaats voor stagiaires en afstudeerders. 
Ook de ideale bijbaan vind je wellicht 
bij OVSoftware. 



I/O VIVAT    

//2228.3

V iermaal per jaar ligt er een 
tijdschrift in de bus met ie-
dere keer weer een andere 
cover. Daarom een kijkje in 
de keuken bij de I/O Vivat, 
hoe wordt zo’n cover ge-
maakt. Een keer iets anders 

dan de gebruikelijke programmeertu-
torials. 

Voorbereiding

Om te beginnen is natuurlijk het pro-
gramma Adobe Photoshop CS6 Ex-
tended nodig, waarschijnlijk voldoet 
CS5 Extended ook. De trial versie is te 
downloaden van de Adobe-website en 
kan 30 dagen zonder problemen wor-
den gebruikt. Controleer wel goed of 
je de extended versie hebt. Dit is nodig 
om met 3D-objecten te kunnen werken. 
Bovendien zijn begrippen en termen 
die ik gebruik in deze tutorial afkomstig 
uit de Engelse versie. 

Naast Photoshop zijn de stock images 
uit de bronnenlijst nodig. De afbeeldin-
gen van de aarde zijn vereist, de vlam-
men en waterspetters zijn aanbevolen 
en kunnen eenvoudig vervangen wor-
den met andere soortgelijke stock ima-
ges.

Stap 1 -  De wereldbol

Om te beginnen maak een nieuw do-
cument in Photoshop met een witte 
achtergrond op A4-formaat. De makke-
lijkste manier om dit te doen is gebruik 
te maken van de presets die beschikbaar 

zijn zodra je op File > New hebt geklikt 
(Ctrl + N). Kies hier ‘International pa-
per‘ met als Size  ‘A4’. Controleer of de 
Resolution ‘300’ Pixels/Inch is en Color 
Mode op ‘RGB’ en ‘8 bit’ staat. Ondanks 
dat drukwerk CYMK is, zal die conver-
sie moeten wachten. Bij het gebruik van 
CYMK zijn veel opties en filters in Pho-
toshop niet beschikbaar. In het geval 
van de I/O Vivat vindt deze conversie 
pas plaats bij het exporteren van InDe-
sign naar een pdf.

Gebruik Image > Adjustments > In-
vert (Ctrl + I) om de witte achtergrond 

zwart te maken. De volgende stappen 
zijn alleen in de extended versie van 
Photoshop uit te voeren. Om een ronde 
bol te maken, moet er eerst een nieuwe 
layer gemaakt worden. Om dit te doen 
kies in het Layer-menu: New > Layer 
(Ctrl + Shift + N) en druk op OK. Ga 
vervolgens naar: 3D > New Mesh from 
layer > Mesh presets > Sphere. Nu zal 
er gevraagd worden of je naar de 3D 
interface wil overstappen. Dit is zeker 
aan te raden voor de volgende stappen. 
Mocht je terug willen naar de normale 
interface, dan kan dit door rechtsboven 
in het lijstje ‘Essentials’ te kiezen.

Figuur 1: Het resultaat na het toevoegen van de drop shadow aan de wolken.

Door: Niels Witte
Lay-outer I/O Vivat

//Artikel

Hoe maak ik de cover van  
deze I/O Vivat?

Photoshop Tutorial 
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Er zal nu een witte bol gemaakt zijn 
en de lijst met layers (rechtsonder) is 
vervangen door het 3D-tabblad, klik 
hier op ‘Sphere_Material’. Om de witte 
bol te veranderen in de aarde moeten 
de gedownloade color en bumb map 
gebruikt worden als materialen. Bij de 
Properties (tabblad rechtsboven) is nu 
het onderdeel ‘Materials’ zichtbaar. Klik 
achter Diffuse op het icoontje rechts van 
het rechthoekje met de kleur en kies 
‘Replace texture’. Kies hier de color map 
die je gedownload hebt bij de voorbe-
reiding. 

Bij Bump doe je het zelfde, maar hier 
kies je de gedownloade bumb map. Ver-
hoog Shine naar 30% en laat de overige 
sliders op hun standaard waarde staan 
(Reflection op 0%, Roughness op 0%, 
Bump op 10%, Opacity op 100% en Re-
fraction op 1,000.). 

In het 3D-tabblad, kies ‘Environment’ 
en verlaag van Shadows de Opacity van 
de Ground Plane naar 0%. Deze scha-
duw gaan we niet gebruiken en kan 
later in de weg zitten. Door de zwarte 
achtergrond is deze nu niet zichtbaar, 
maar wanneer we met de achtergrond 
beginnen zal deze zichtbaar worden.

Door op ‘Sphere’ te klikken in het 3D-
tabblad en de ‘move tool’ (sneltoets: V) 
te gebruiken kun je de aardbol draaien. 
Het draaien kan wat lastig zijn, zelf ge-
bruik ik voornamelijk de randen van de 
kubus die zichtbaar worden na het se-
lecteren van ‘Sphere’.

Stap 2 – In de wolken

Eenmaal de juiste positie gevonden 
schakelen we over naar het layers-tab-
blad, naast het 3D-tabje rechtsonder. 
Hernoem vervolgens layer 1 naar ‘Pla-
net’ door dubbel te klikken op het label 
in de lijst met layers. Dupliceer deze lay-
er door met de rechtermuisknop te klik-
ken op de layer en ‘duplicate’ te kiezen. 
Geef als naam ‘Clouds’ op. Deze layer 
zal het wolkendek van de aarde voor 
zijn rekening nemen. 

Selecteer de Clouds-layer en ga te-
rug naar het 3D tabblad en kies ‘Sp-
here_Material’. Bij diffuse klik je op het 
icoontje en kies ‘Remove texture’ en als 
diffuse kleur kies hier wit (#FFFFFF). 
Verwijder ook de bumb map. Als het 
goed is, heb je nu weer een witte bol 
over gehouden

Bij Opacity laadt de cloud transparency 
map en klik nogmaals op het icoontje 
en kies ‘Edit texture’ om de transparen-
cy map te bewerken. Een Opacity mask 
werkt hetzelfde als een Layer mask. 
Hierbij bepaald de gebruikte grijstint de 
transparantie, waarbij zwart helemaal 
transparant is wit helemaal zichtbaar. 
De kleuren van deze clouds transparen-
cy map zijn dus net verkeerd om. Kies 
in de menubalk: Edit > Adjustments 
> Invert (Ctrl + I). Sluit dit tabblad en 
druk op ja als er gevraagd wordt om de 
wijzigingen op te slaan.

Nu is er nog een probleem. De wolken 
die aan de achterzijde van de aarde zijn, 
zijn ook zichtbaar. Door ‘Scene’ te kie-
zen in het 3D-tabblad en in vervolgens 
in het Properties-tabblad de optie ‘Re-
move hidden: Backfaces’ aan te vinken 
zal dit probleem opgelost worden. Door 
weer op ‘Sphere’ te klikken en de ‘move 
tool’ te gebruiken kun je de wolken 
draaien tot je tevreden bent.

Schakel terug naar de ‘Essentials’ 
workspace. Om iets meer diepte toe 
te voegen, gaan we de wolken een 
schaduw geven. Dubbel klik op de 
Clouds-layer (niet op het label of de 
thumbnail, maar in de loze ruimte er-
omheen) om het layer styles-scherm te 
openen. Kies ‘Drop Shadow’ en gebruik 
de volgende waarden: Blending mode 

‘Multiply’, Opacity: 75%, Angle: 120, 
Distance: 5px, Spread: 0% en Size: 5px.  
Als het goed is, heb je ongeveer iets dat 
lijkt op Figuur 1.

Aan de Clouds-layer gaan we een Layer 
mask toevoegen om de wolken langs 
de randen iets te verbergen. Selecteer 
de Clouds layer en klik met Ctrl inge-
drukt op de thumbnail in de lijst met 
layers om een selectie te maken van de 
wereldbol.

In de menu balk kies: Select > Modify > 
Contact, en gebruik een waarde van 50 
pixels om de selectie kleiner te maken. 
Om de overgang geleidelijk te maken, 
kies in de menubalk: Select > Modify > 
Feather, en gebruik ook hier een waarde 
van 50 pixels. 

Nu we de juiste selectie hebben, gaan we 
een Layer mask toevoegen. In de menu 
balk kies: Layer > Layer mask > Reveal 
Selection. Dit zal alleen het geselecteer-
de gebied zichtbaar maken en de rest 
verbergen.

Nog één laatste stap om ook de planeet 
iets donkerder te maken langs de ran-
den. Dubbel klik op de Planet-layer om 
het layer styles-scherm te openen. Kies 
‘Inner Shadow’ en verhoog Opacity naar 
100%, vink ‘Use Global Light’ uit en ge-
bruik een Angle van -90. Verhoog ver-

Figuur 2: Het resultaat na het toevoegen van de vlammen.
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volgens Distance naar 100 pixels, zorg 
dat Choke op 0 pixels staat en Size op 
250 pixels.

Nu hebben we een mooie wereldbol 
met wolken op een hele donkere achter-
grond. Echter is de kwaliteit van de 3D-
objecten vaak acceptabel maar niet heel 
hoog in Photoshop. Door deze te rende-
ren, zal dit vaak behoorlijk verbeteren. 
Dit kan door in het 3D-menu in de me-
nubalk de optie ‘Render’ te kiezen als er 
een 3D-layer geselecteerd is. In dit geval 
is het niet nodig, het renderen duurt te 
lang en het resultaat zal niet significant 
veel beter worden.

Stap 3 - Vlammen

Selecteer de Planet en de Clouds layers 
door met Ctrl ingedrukt op de layer 
(niet de thumbnail) te klikken. Als ze 
beide geselecteerd zijn, ga in de menu-
balk naar Layers > Group Layers (snel-
toets Ctrl + G). Hernoem deze groep 
naar: ‘World’.

Maak boven de World-groep een nieuw 
groep aan. Door op het map-icoontje te 
klikken onderaan het lijstje met layers. 
Noem deze groep ‘Flames’. Nu gaan de 
afbeeldingen van vlammen gebruikt 

worden om de aardbol aan de rech-
terkant in vuur en vlam te zetten. Het 
importeren van een bestand gaat door 
in de menubalk ‘File > Place’ te kiezen, 
daar één van de drie afbeeldingen van 
vuur te openen en vervolgens op Enter 
te drukken. De afbeelding is over bijna 
heel het document uitgerekt, maar dat 
is geen probleem aangezien de afbeel-
dingen een hoge resolutie hebben. Ver-
ander de Blending mode van het vuur 
naar ‘Screen’ om het zwart doorzichtig 
te maken. De Blending modes staan bo-
venaan het lijstje met layers, standaard 
is ‘Normal’ geselecteerd. 

Verklein de afbeelding van de vlam-
men zodat deze mooi naast de aardbol 
staat. De eenvoudigste manier om dit te 
doen is de Move tool te selecteren en te 
zorgen dat bovenaan het scherm de op-
tie: ‘Show transform controls’ aanstaat. 
Vervolgens kan Wrap gebruikt worden 
om de vlammen rondom de zijkant van 
de aardbol te laten branden. Wrap is Te 
vinden middels: Edit > Transform > 
Wrap. Sleep de hoeken, de randen en de 
vakken van het raster tot de vlammen 
mooi om de rechterhelft van de wereld-
bol gewikkeld zijn. Dit proces is een 
kwestie van veel proberen, het gaat vaak 
niet in één keer helemaal goed. Geluk-

kig is er de optie om een aantal stappen 
ongedaan te maken: Edit > Step Back-
wards (Ctrl + Alt + Z).

Een Layer mask kan gebruikt worden 
om de overbodige stukken vuur weg te 
halen, gebruik hiervoor een soft edged 
brush en zwart als kleur. Kies de brush 
tool en klik met de rechtermuisknop in 
document om de Hardness op 0% te zet-
ten, kies een standaard ronde brush. Pas 
de grootte van de brush aan naar wens. 

Herhaal dit en gebruik de andere vuur-
afbeeldingen om tot een resultaat te 
komen waar jezelf tevreden over bent. 
Mijn resultaat is zichtbaar in Figuur 2.

Zelf heb ik de vlammen die over de 
aardbol heen gaan wat gedimd door met 
een zwarte brush, waarvan de Hardness 
op 0% staat, de layer masks van de vlam-
men bij te werken.

Stap 4 – Waterspetters

Naast de vlammen zal de linkerkant van 
de aardbol voorzien worden van water-
spetters. Dit werkt ongeveer hetzelfde 
als bij de vlammen. Maak een Layer 
group aan en importeer de afbeeldingen 
van de water spetters. Omdat de spetters 
op een zwarte achtergrond zitten maakt 
het niet uit dat er bijvoorbeeld een glas 
onder staat. Deze is eenvoudig weg te 
halen met behulp van een Layer mask 
en door de Blending mode op ‘screen’ te 
zetten zal de zwarte achtergrond door-
zichtig worden. Na enkele transforma-
ties en het toevoegen van layer masks 
op een soortgelijke wijze als bij de vlam-
men zou het voorlopige resultaat iets 
weg moeten hebben van figuur 3.

Stap 5 – De achtergrond

Om het geheel nog net iets beter naar 
voren te laten komen is er nog een ach-
tergrond nodig. Net boven de zwarte 
achtergrond-layer moet een nieuwe lay-
er aangemaakt worden, noem deze layer 
‘Nebula.’ Selecteer de nieuwe layer, kies 
als voorgrondkleur zwart (#000000) en 
als achtergrondkleur een donkere grijs 
(bijvoorbeeld: #555555). Vul hierna de 
achtergrond door de Clouds-filter te ge-
bruiken. Deze staat in het Filter-menu 
onder ‘Render > Clouds’. Hierdoor zal 
de achtergrond gevuld worden met de 
zwart en donkergrijs, om dit effect nog 
iets te versterken gebruik drie of vier 
keer de Difference Clouds-filter, deze Figuur 3: Nu ook het water toegevoegd aan de linkerzijde.
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is te vinden in het Filter-menu onder 
‘Render > Difference Clouds’.

Kies nu als voorgrondkleur een fel blau-
we kleur (#00FFFF) en als achtergrond-
kleur een fel groene kleur (#00FF00). 
Dubbel klik op de layer met de clouds-
achtergrond om het layer styles-scherm 
te openen. Kies hier ‘Gradient Overlay’ 
gebruik als Blend Mode ‘Overlay’ en kies 
als Gradient de eerste linksboven, met 
de blauw en groen die als voor- en ach-
tergrondkleur ingesteld staan. Verander 
de Angle naar 140. Klik op OK en wijzig 
de Blending mode van de layer ook naar 
‘Overlay’ en wijzig het percentage ach-
ter Fill naar 75%.

Nu is de hele layer onzichtbaar, om een 
deel ervan zichtbaar te maken zijn nog 
enkele stappen nodig. Maak een nieuwe 
layer onder de Nebula-layer aan en vul 
deze layer met de Clouds-filter, zorg dat 
zwart en wit geselecteerd zijn als res-
pectievelijk voor- en achtergrondkleur. 
Gebruik hierna de Gaussian blur-filter 
om het effect van de wolken iets te ver-
zachten. In het Filters menu kies ‘Blur 
> Gaussian blur’ en gebruik 100px als 
waarde.

Boven de lijst met layers is, in de Es-
sentials workspace, een Adjustments-
scherm. Kies hieruit het tweede plaatje 

linksboven: Levels. Onder het grafiekje 
dat te voorschijnkomt en dat een soort 
van normaalverdeling weergeeft staan 
drie pijltjes, een zwarte, een grijze en 
een witte. Door het zwarte pijltje naar 
het midden te schuiven zal een deel van 
de blauwgroene achtergrond verdwij-
nen. Schuif vervolgens de grijze pijl tot 
bijna tegen de witte aan, tot je tevre-
den bent over de hoeveelheid zichtbare 
groenblauwe wolken. Voor mij kwam 
het uit op 100 voor zwart, 0,4 voor grijs 
en 255 voor wit.

Voor de finishing touch moet er boven 
de Clouds-layer nog een nieuwe layer 
aangemaakt worden, met als naam 
‘Stars’. Door met een brush, grootte van 
3px en Hardness op 100%, en wit als 
voorgrondkleur op willekeurige plaat-
sen een witte stip te zetten worden de 
eerste sterren geboren. Zet ook stippen 
met een brush van 5px en 10px om meer 
diversiteit te krijgen. Herhaal dit tot je 
tevreden bent over het resultaat. Voeg 
vervolgens een ‘Outer Glow’ toe aan de 
Stars-layer door dubbel te klikken op de 
layer, het Layer styles-scherm te openen 
en hier ‘Outer Glow’ te kiezen. Gebruik 
als kleur Wit (#FFFFFF) en verander de 
Size naar 10px. Klik op OK en verander 
de Opacity van de Stars-layer naar 50% 
om de sterren iets minder vel te maken. 
Een voorbeeld van het resultaat is te 

zien in Figuur 4.

Eindresultaat

In dit tutorial is de basis gelegd voor de 
cover van deze I/O Vivat. Veel van de 
gebruikte technieken kunnen natuurlijk 
gebruikt worden in andere projecten. 

Stock Images
Aardbol (color map, bump map, cloud 
transparency):
http://planetpixelemporium.com/
earth.html

Vlammen: 
http://www.sxc.hu/photo/1093986
http://www.sxc.hu/photo/1093984
http://www.sxc.hu/photo/1093987 

Waterspetters: 
http://www.sxc.hu/photo/1374771
http://www.sxc.hu/photo/1131843

Figuur 4: Het resultaat na het toevoegen van de sterrenachtergrond.
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Door: Pim Jager
Voorzitter Inter-Actief

//Column

YOLO

Van de voorzitter

Pim Jager opende voor de eerste 
maal zijn ogen op 29 augustus 
1990 in het altijd bruisende Utrecht. 
Na een glansrijke carrière op basis-
school de Zonheuvel in het immer 
gezellige Driebergen (incidenteel 
ook de plaats waar Pim tot zijn 
studie in Twente woonachtig is ge-
weest) was het tijd voor de volgen-
de logische stap en begon Pim aan 
zijn VWO-opleiding aan het Revius 
Lyceum in het pittoreske Doorn. Na 
zes jaar was duidelijk dat het VWO-
onderwijs hem weinig uitdaging meer 
kon bieden en het tijd was voor een 
nieuwe uitdaging. Deze nieuwe uit-
daging vond Pim aan de Universiteit 
Twente, na een wat moeilijk begin, 
waarin de verkeerde keuzes zijn ge-
maakt (de nasleep van deze keuzes 
zijn nog terug te vinden in zijn pri-
mair lidmaatschap bij E.T.S.V. Scintil-
la) zag hij na twee weken studeren 
alsnog het licht en schreef hij zich 
in bij I.C.T.S.V. Inter-Actief. Na onder 
andere actief te zijn geweest in de 
ECie, Kick-IT, FlitCie, Cinema, Tost-
Cie en EWI-trip is hij tegenwoordig 
voorzitter van het 34e bestuur der 
I.C.T.S.V. Inter-Actief.

De gemiddelde Inter-Actiefer 
zul je niet snel betrappen 
op het gebruik van deze 
term. Begrijpelijk ook: de 
uitspraak “You Only Live 
Once” wordt toch vooral 
geuit door 13-jarige scho-

liertjes. We voelen ons allemaal graag 
jong, maar dan toch liever een leeftijd 
waarop we legaal een biertje kunnen 
halen. Eigenlijk is het jammer dat de 
uitspraak zo geïnterpreteerd wordt; 
links en rechts wordt YOLO gebruikt 
als excuus voor achterlijke en ondoor-
dachte acties.

Een Inter-Actief-waardig alternatief 
voor YOLO is Carpe Diem: pluk de 
dag. Het principe is hetzelfde, maar de 
subtiliteiten liggen totaal anders. Beide 
impliceren weliswaar dat je moet le-
ven in het nu, maar in tegenstelling tot 
YOLO, impliceert Carpe Diem dat je 
ook wat wilt maken van je dag. Niet met 
190 dronken door een woonwijk, maar 
borrelen met vrienden, een interessant 
symposium of een gave activiteit. Niet 
alleen genieten van de dag van vandaag, 
maar ook in de gaten houden dat er in 
de toekomst nog van dagen te genieten 
valt. Genieten met toekomstperspectief, 
als het ware.

In de afgelopen tijd hebben we kunnen 
zien dat dit ook de manier is waarop we 
er hier bij Inter-Actief mee omgaan. Op 
de altijd gezellige borrels en activiteiten 
hebben we dit samen in de praktijk ge-
bracht. Immers drink je niet alleen op 
dat moment gezellig een biertje met 
vrienden, maar bouw je ook contac-
ten op met leden uit andere jaren. Op 
de korte termijn is dat natuurlijk uiter-
mate gezellig, maar vooral op de lange 
termijn is het hebben van zo’n netwerk 
nuttig. Bij het vinden van een baan, of 

samenwerking met een ander bedrijf 
kan het natuurlijk nooit kwaad als je 
al contacten van je tijd hier binnen dat 
bedrijf hebt. Een ander goed voorbeeld 
hiervan is het symposium. Op een dag 
vol interessante lezingen hebben we 
kennis gemaakt met interessante bedrij-
ven en sprekers uit het werkveld. 

Natuurlijk gaan we ook de aankomende 
tijd weer genieten van onze dagen. Met 
onder andere de EWI-trip, Pandora, en 
de Business Course. Uiteraard zullen we 
ook weer elke dinsdag onder het genot 
van een broodje kennis maken met een 
interessant bedrijf en  de dag afsluiten 
met een gezellige (buiten)borrel. Kort-
om, houd de activiteitenagenda goed in 
de gaten en laat geen kans onbenut om 
het maximale uit je dag te halen. Carpe 
Diem!
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Mark Steunenberg is penningmees-
ter van ENIAC: de ENschedese In-
formatica Alumni Club. ENIAC is de 
alumnivereniging voor de bachelor- 
en masteropleidingen Technische 
Informatica, Telematica en Bedrijfs-
informatietechnologie aan de Uni-
versiteit Twente.

Voor slechts €5,- ben je al lid van 
ENIAC. Je ontvangt dan vier keer per 
jaar het populair-wetenschappelijk 
magazine I/O Vivat, bent uitgeno-
digd voor alle activiteiten, en houd 
op deze manier contact met je oud-
studiegenoten. Ook afgestudeerde 
Bachelor-studenten worden van 
harte uitgenodigd om lid te worden. 
Aanmelden kan via de website.

ENIAC heeft met Inter-Actief de 
afspraak gemaakt dat activiteiten 
van beide vereniging toegankelijk zijn 
voor leden van beide verenigingen. 
Als lid van Inter-Actief ben je dus 
van harte welkom bij de activiteiten 
van ENIAC, en als alumnus kun je 
ook de activiteiten van Inter-Actief 
bezoeken. Communicatie van de be-
langrijkste activiteiten vindt plaats 
via de Inter-Actief weekmail en 
ENIAC Buzz.

Mark Steunenberg

penningmeester@eniac.utwente.nl

http://www.eniac.utwente.nl

vereniging waar je je onwijs thuis voelt?

Heb je gekozen wanneer het einde is, 
dan mag je daarna gaan kiezen waar je 
naar toe wilt. Wil je in het oosten blij-
ven wonen? Naar de grote stad? Of toch 
het dorp van je ouders? Een belangrijke 
keuze want het bepaalt voor een groot 
deel naar welke bedrijven je op zoek 
kunt gaan.  Dankzij alle lunchlezingen 
bij Inter-Actief, die je natuurlijk alle-
maal hebt bezocht, heb je hier in ieder 
geval een goed beeld van! Een software-
huis, de consultancy, een bank, een so-
cial media start-up of misschien toch 
wel bij de (semi-)overheid.  Allemaal 
zijn ze verschillend, bieden best wel an-
dere voorwaarden maar ook werken er 
gewoon hele andere mensen. Wennen 
aan je 9 tot 5 baan, of is het een 8 tot 
8 baan geworden? Zo veel keuzes, maar 
ook zo veel kansen. Als afgestudeerde 
informaticus of BIT’er heb je echt geen 
probleem met een baan vinden. Zelfs 
niet  in deze tijden van crisis. 

Dankzij de historische gegevens van 
onze ENIAC-leden hebben we wel een 
voorspelling wat er met jou gaat gebeu-
ren. Je gaat verhuizen naar een grote 
stad in Midden-Nederland. Van het 
noord en zuid Nederland blijf je in elk 
geval weg. Je wordt consultant of anders 
software engineer en je verdient bakken 
met geld. Je hebt tenslotte wel een tech-
nische opleiding gedaan!

In de titel staat overigens bewust stu-
dententijd en niet studietijd. Die laatste 
moet ik nog afsluiten.

Mark Steunenberg, Penningmeester

I k hoor vaak dat op kamers gaan 
een van de grootste veranderin-
gen is die je in je leven kan mee-
maken. Ik ben het er niet mee 
eens. Het werkende leven is echt 
een veel ingrijpendere verande-
ring. Hierbij een kijkje wat er 

allemaal bij komt kijken. Om goed 
te relateren aan de veranderingen die 
er dan allemaal zijn is het misschien 
goed om even het studeren en het op 
kamers gaan er bij te pakken.

Op het moment dat je op kamers gaat, 
nemen je ouders altijd emotioneel af-
scheid van je. In de meeste gevallen 
wordt je ook nog eens overstelpt met 
alle nutteloze zaken die je moeder al ja-
ren aan het opsparen is.  Als je in een 
studentenhuis gaat wonen zijn de mees-
te van deze dingen er al. Weinig van je 
medehuisgenoten zitten te wachten op 
de schattige konijnenbekertjes die je 
moeder in 1998 apart had gelegd voor 
de uitzet van haar kleine engel.

Je moet veel dingen opeens zelf doen. 
Koken voor je huis, terwijl je net het 
pakje Bolognese saus kunt klaarmaken. 
Je eigen was draaien; nooit had je een 
idee dat zoiets zo veel tijd zou kosten. 
Toch vallen deze veranderingen reuze 
mee. Je huisgenoten zijn er tenslotte om 
je te helpen. Ze helpen je graag met het 
koken van een lekkere maaltijd. Het ni-
veau van het Bolognese pakje ontstijg je 
snel.

Het einde van je studententijd gaat een 
stuk minder soepel. Opeens moet je 
veel belangrijke keuzes gaan maken. De 
allereerste keuze die je moet maken is 
wanneer je studententijd is afgelopen. 
Ga je voor de master die je makkelijk 
in twee jaar afrondt, of doe je nog dat 
ene bestuursjaar bij die super gezellige 

Door: Mark Steunenberg
Penningmeester ENIAC
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Je leven op zijn kop.

Van het ENIAC-bestuur
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Reading human thoughts and 
intention has been one of 
man’s biggest fantasies in re-
cent times and over the years, 
these fantasies have trickled 
into our popular media as 
well. In the 1983 film Brain-

storm, Christopher Walken playing 
a scientist, was able to record mov-
ies of people’s mental experiences, 
then play them back into the minds 
of other people. More recently, in 
2010, in the episode Black Hole of the 
popular TV series, House M.D., Dr. 
House was able to make a medical 
diagnosis of a patient suffering from 
hallucinations. By using a fictitious 
sci-fi gadget, dubbed the ‘Cognitive 
Pattern Recognition’ device, the doc-
tor was able to tap into the patient’s 
brain and visualize reconstructions 
of the hallucinogenic thoughts as they 
were happening in the patient’s brain. 
Although these scenarios might seem 
like a huge stretch of imagination, the 
current state of the art is getting fairly 
close to making these fictions a reality. 
In a ground breaking study in 2011, 
researchers at UC Berkeley, utilizing 
functional Magnetic Resonance Im-
aging (fMRI) and computer models, 
demonstrated the visual reconstruc-
tions of brain activity of human sub-
jects watching movie trailers (see Fig-
ure 1); in other words, they could see 
what the people’s brains were seeing. 
Hence mind reading is no longer a sci-
ence fiction. 

Although decoding of mental activ-

ity has been demonstrated in many 
prior fMRI studies, none of them were 
performed in real time. In all these ex-
periments, brain images were collected 
from the subjects in an MRI scanner 
during long scanning sessions. After all 
the data had been acquired, it took sev-
eral hours to build the models or train 
the classifiers, and then these models/
classifiers were used offline on a por-
tion of the previously collected data to 
predict the brain state of the subject at 
the time data was originally acquired. 
If mind reading is to be viable for any 
future mind reading application, then 
the decoding has to be done on-the-fly. 
In other words, decoding the mental ac-
tivity of a person should be done while 
these mental states are being gener-
ated in the brain. That’s where our work 
comes into the picture. We designed a 
real-time fMRI processing pipeline, 
which can analyze fMRI images as soon 

as these images are acquired by the 
scanner thereby allowing us to decode 
human mind and thoughts as soon as 
they are produced in the brain. By using 
smarter and faster algorithms to process 
fMRI data, we reduced the processing 
time of fMRI scans from hours to less 
than a second. The goal of this article 
is not explain choke you with the nitty-
gritty of these algorithms but to explain 
how the developed system has been 
deployed successfully to perform some 
cool mind reading experiments.

Decoding visual attention

In our daily life, we are continuously 
flooded with multiple information 
streams, each competing for our atten-
tion.  However, only a small amount of 
information can be assimilated at any 
given time due to limited information-
processing capacity of the human mind. 

Figure 1: A decoding study performed at UC Berkeley in 2011. A short clip of Steve Martin 
in Pink Panther 2 was presented to the subject and it was recreated from the fMRI images 

to produce the representation on the right.

Door: Adnan Niazi
Researcher at Donder Institute for Brain, Cognition and Behavior (Former Master student Human Media Interaction)

Reading minds with brain imaging

Real-time fMRI decoding

//ENIAC
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To effectively cope with this influx of 
information, the brain must filter out 
task-relevant information from the en-
vironmental stimuli based on current 
task demands. Selective attention drives 
this filtering by focusing processing re-
sources on particular aspects of the en-
vironment or stimuli, whilst disregard-
ing others. So in our first experiment, 
we wanted to investigate if we can de-
code visual attention while it’s happen-
ing in the brain. To do that, we scanned 
subjects in an MRI scanner, and while 
they were being scanned, they were 
shown superimposed picture of a face 
(Jim Carey) and a scene (Eiffel Tower) 
as shown in Figure 2.  The subject’s task 
was to attend to only one of these pic-
tures, i.e. either Jim Carey or the Eiffel 

Tower. The fMRI brain images acquired 
during this time were immediately de-
coded to find which of the two picture 
the subject was attending to at any given 
time. 

But how is it possible to find what 
people are attending to? Well, a human 
brain has certain distinct regions for 
processing faces and scenes. By figur-
ing out which of these two regions was 
more activated, the computer was able 
to predict which of the two pictures 
(Jim Carrey or Eiffel tower) the subject 

was attending to. The system was able 
to decode the attended picture with 
80% accuracy.  We demonstrated that 
the semantic contents of the human 
mind can be decoded in real time and 

with very high accuracy. This study will 
prove instrumental in future research to 
explore if the humans can be trained to 
lengthen or improve their attentional 
span which can be very useful for atten-
tion demanding jobs.

Decoding visual perception

In our second experiment we took 
things a bit further. Rather than decod-
ing the high-level semantic category in-
formation (face or scene) of the stimuli, 
we wanted to investigate if we can also 

decode low-level details such as the 
shape of the stimulus. More specifically, 
we wanted to investigate if we can de-
code complex shapes such as alphabets 
from the human visual cortex. So in this 

experiment, we showed some alphabets 
to the subjects while they were being 
scanned in the MRI scanner. The fMRI 
brain images acquired during this time 
were then analyzed and the perceived 
alphabets were reconstructed from 
these fMRI brain images. But how is it 
possible to infer the shape of perceived 
stimuli from activations in human vi-
sual cortex? The answer lies in a break-
through made by Roger Tootell in 1970 
which showed that the visual cortex is 
retinotopically organized. In that ex-
periment, a geometric pattern of flash-

Figure 2: Superimposed pictures of Jim Carey and Eiffel Tower were presented and the subjects were asked to attend to only one of them. 
Using real-time fMRI, we were able to decode which of the two pictures the subject was attending to at any given time.

“If mind reading is to be viable for any 
future mind reading application, then the 

decoding has to be done on-the-fly”

Figure 3: Tootell’s experiment in which flashing circular patterns were shown to a monkey. 
The exact same pattern was found to be imprinted on the visual cortex, implicating that 

the visual cortex is retionotopically organized.
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ing lights was shown to a monkey after 
it was injected with a radioactive sugar, 
which is taken up into brain cells in 
proportion to their level of activity. This 
stains the brain cells which are active. 
In other words, the radioactive sugar 
traces out those cells in the brain that 
responded to light. The monkey was 
trained to stare at the stimulus and was 
then sacrificed so that its brain could be 
examined. The occipital cortex of the 
monkey showed dark bands revealing 

those neurons that were most activated 
while the animal viewed the pattern. 
Surprisingly, this pattern of activation 
in the brain resembled the geometric 
structure of the stimulus seen by the 
monkey (see figure 3).

Tootell’s experiment was a remarkable 
demonstration of how the visual cor-
tex is retinotopically organized i.e., this 
part of the brain is organized similarly 
to how the light hits our retinas. Ev-
erything that we see, gets mapped in a 
certain specific manner onto the visual 
cortex. If only we can somehow learn 
this stimulus-to-cortical activation 
mapping non-invasively, then we can 
use it to infer the shape of almost any 
stimuli presented in the visual field. 

To learn this mapping, we first present-
ed totally random patterns to subjects 
and used the corresponding fMRI brain 
images to train an elastic net logistic 
regression classifier. Once the classi-
fier learned how various regions in the 
visual field get mapped onto the visual 
cortex, we presented alphabets to the 

subjects in the visual field. Using the 
fMRI brain activations of the alphabets 
and the previously trained classifier, 
we were able to infer the shape of the 
perceived alphabet. In essence, it’s like 
reverse engineering the shape of the 
alphabet that subject was seeing from 
the cortical activations elicited by that 
alphabet. The results of this decoding is 
shown in figure 4.

The next step in this research would be 

to decode imagined alphabets. Research 
has shown that activation patterns for 
imagined stimuli are more or less the 
same as perceived stimuli. If visual 
perception and imagination share the 
same neural substrates, then a classifier 
trained for decoding perceived stimuli 
can also be used to decode imagined 
stimuli. This research is currently under 
way, and if we are successful, it would 
result in a true thought reading device.

Future of mind reading

Although mind reading though still in 
its infancy, the technology will make a 
profound impact on the lives of many. 
It would permit the profoundly handi-
capped, those paralyzed by conditions 
such as motor-neuron disease and ce-
rebral palsy, to communicate more eas-
ily. It might unlock the mental prison 
of patients suffering from diseases like 
Locked in Syndrome (LIS). For the 
able-bodied, it could allow workers to 
dictate documents silently to comput-
ers simply by thinking about what they 
want to say. And most importantly, such 

a device might one day be able to detect 
lies and help judicial systems to pros-
ecute criminals and deliver justice.

Figure 4: The top rows shows the alphabets that were seen by the subjects. The bottom 
shows the alphabets reconstructed from the fMRI brain activations.

“Our system demonstrated that the se-
mantic contents of the human mind can 

be decoded in real time and with very 
high accuracy”
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